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1 Overview
This document provides a comprehensive overview of the SCPI (Standard Commands for Programmable

Instruments) commands and queries supported by the Magnova BMO oscilloscope. SCPI is an established
standard for controlling and communicating with test and measurement instruments, enabling users to auto-
mate complex measurements and integrate devices into larger testing systems.

SCPI builds upon the IEEE 488.1 and IEEE 488.2 standards, which define the physical, electrical, and
protocol layers for communication with programmable instruments. By adhering to these standards, SCPI
ensures compatibility across a wide range of instruments, facilitating seamless integration into automated
testing environments.

In addition to listing the supported commands, this document provides detailed descriptions of each com-
mand, including their syntax and functionality. The commands are organized based on relevancy to typical
use cases, though the importance of specific commands may naturally differ depending on individual user
needs and applications. Programming examples are included to demonstrate how these commands can be
effectively utilized over USB and Ethernet using various protocols such as USBTMC, raw sockets, HiSLIP (not
yet unlocked as of firmware version 1.2.1), and a REST API, making it straightforward for users to implement
them in real-world applications.

By following this guide, users can unlock the full potential of the Magnova BMO’s programmable interface,
streamlining measurement workflows, enhancing data accuracy, and reducing manual intervention. This
document is intended for engineers, researchers, and developers seeking to leverage SCPI for automation in
laboratories, manufacturing environments, and educational settings.

1.1 Syntax
A small summary of the syntax is provided in the following section.

1.1.1 Commands and Queries

SCPI commands and queries on the Magnova BMO oscilloscope follow a structured syntax. Each command
or query comprises a header and, optionally, a list of parameters. The header begins with either a colon (:)
for device-specific commands or an asterisk (*) for common commands. Path components within the header
are separated by colons (:), and a question mark (?) at the end of the header signifies a query. Parameters,
if present, are separated by commas (,) and follow a space after the header. Importantly, there must be no
spaces between the parameters themselves. Commands can also be combined into a composite command
by separating them with semicolons (;); however, only the result of the last query in the sequence is returned.

Examples

• To enable the first analog channel:
:CHANnel1:STATe ON

• To query whether the first analog channel is enabled:
:CHANnel1:STATe?

• To query packed waveform data from the second analog channel:
:CHANnel2:DATA:PACKed? SCReen,V

• Composition of multiple commands:
:CHANnel1:STATe ON; :TRIGger:TYPE EDGe
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1.1.2 Parameters and Return Values

The following types are used in both commands and return values.

• Discrete

For discrete types, the possible values are explicitly listed and follow the same naming convention as
the commands and queries themselves. For example:

– ON
– SCReen

• Integer

An integer, which may be constrained to a specific range if specified; it is important to note that a
decimal in this context will result in an error.

• Real

A real number, which may be constrained to a specific range if specified.

• ASCII

A string of ASCII characters.

• Block Data

See 1.1.3.

Some parameters specify possible units. This allows users to optionally specify the value in engineering
notation, including the unit. For example:

• 50mV

• 1.25dBm

The usage of a unit is always optional. However, when a unit is used, it must be one of the specified units.
Return values never use a unit. For example:

• 0.05

• 1.25

1.1.3 Block Data

Queries that return large amounts of data are formatted using the definite-length binary block format as de-
fined by the IEEE 488.2 standard.

Field
Count
(bytes)

Description Example

# 1 Hash character indicating block start #

N = Digits 1 Length of byte count (number of digits) 5 (ASCII)

M = Byte Count N Number of data bytes 12345 (ASCII)

Binary Data M The actual binary data Binary sequence

Unless explicitly specified, binary data uses little-endian byte order.

Depending on the API used to send SCPI commands and evaluate return values, the processing of the
definite-length binary block format is typically handled automatically. However, the little-endian byte order
may need to be explicitly specified.

The concrete block data definition in this document includes a JSON/XML Tag. When the RESTful API is
used, the binary layout is ignored and the data is returned in fields with their respective names.
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1.1.4 Abbreviation

The names of commands and parameter values are provided in their long form but can be abbreviated by
using only their short form (upper case parts). For example:

• :CHAN1:STAT ON

• :CHAN2:DATA:PACK? SCR,V

When abbreviating, the abbreviation must be complete and consistent. Partial abbreviations are not valid.
For instance:

• :CHANn1:STAT ON (invalid due to incomplete abbreviation)

• :CHAN2:DATA:PACK? SCRee,V (this also applies to parameters)

It is important to note the special case of numbers at the end of a name. These numbers remain unchanged
regardless of whether the long or short form is used.

1.1.5 Notes

All commands operate synchronously unless explicitly stated otherwise.

1.2 Interfaces
This section outlines the available communication interfaces that serve as transport mediums for SCPI.

1.2.1 Common

The following common communication interfaces are currently supported:

• Raw sockets
Raw sockets provide a lightweight communication method that allows direct transmission of SCPI com-
mands over a network using TCP/IP without additional protocol overhead. Ideal for simple setups where
minimal latency is required.

See Section 2.2 for an example on how to use raw sockets.

• USBTMC
The USB Test and Measurement Class protocol enables communication with SCPI devices via USB. It
provides a standardized way to control instruments and transfer data using USB connections.

See Section 2.1 for an example on how to use USBTMC.

• HiSLIP
The High-Speed LAN Instrument Protocol is a network-based protocol designed for SCPI communica-
tion. It offers improved performance and capabilities compared to traditional raw sockets and is suited
for modern, high-speed instruments.

Note: Not yet unlocked as of firmware version 1.2.1.

1.2.2 RESTful API

In addition to the commonly used and well-documented interfaces, a RESTful API (Representational State
Transfer) is also available. REST is an architectural style for designing networked applications that uses stan-
dard HTTP methods (such as GET, POST, PUT, DELETE) to perform operations on resources. This stateless
communication approach ensures that each request from a client to the server is independent and contains
all the necessary information, making it versatile for various applications and easy to integrate into different
systems.

See Section 2.3 for an example on how to use the REST API.
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Note: All provided REST API requests that return application/json can also return application/xml if re-
quested.

Version Get the device firmware version.

GET /version
Get the device firmware version

Parameter
no parameter
Response application/json
200 ok

{
"Major": 1,
"Minor": 1,
"Revision": 7

}

Screenshot Take a screenshot of the currently displayed device screen.

GET /screenshot
Get a screenshot

Parameter
no parameter
Response image/png
200 ok

SCPI Interact with the SCPI interface.

GET /scpi
Get an alphabetically sorted list of available commands and queries

Parameter
no parameter
Response application/json
200 ok

{
"*CLS",
"*ESE",
...,
"CHANnel1:STATe",
"CHANnel1:SCALe",
...

}
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POST /scpi
Execute a command

Parameter
no parameter
Body application/json

":CHANel1:STAT ON"

Response application/json
200 ok

404 error: command not found

400 error: invalid syntax

"Invalid command syntax"

400 error: invalid parameters

"Invalid command parameters"

POST /scpi
Get the result of executing a query

Parameter
no parameter
Body application/json

":CHANel1:STAT?"

Response application/json
200 ok

"ON"

404 error: command not found

400 error: invalid syntax

"Invalid command syntax"

400 error: invalid parameters

"Invalid command parameters"
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2 Examples
The following section provides several examples of using SCPI commands to remotely control the instrument
via various protocols in Python. See also https://github.com/Batronix/MagnovaExamples for more examples.

2.1 Simple instrument commands and queries using USBTMC
In this example, the instrument’s unique identifier is queried, the first analog channel is enabled, and the
acquisition is started.

#!/usr/bin/python3

import pyvisa

# Open the instrument using a USBTMC connection
rm = pyvisa.ResourceManager()
instr = rm.open_resource(’USB0::0x19B2::0x0030::[YOUR_SERIAL_NUMBER]::INSTR’)

# Query the unique identifier
print(instr.query(’*IDN?’))

# Enable the first analog channel
instr.write("CHAN1:STAT ON")

# Start the acquisition
instr.write("RUN")

https://github.com/Batronix/MagnovaExamples
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2.2 Waveform Plot using raw sockets
In this example, waveform data is queried in packed format, requiring the metadata to be separated from the
waveform samples.

#!/usr/bin/python3

import matplotlib.pyplot as plt
import numpy as np
import pyvisa
import struct

# Open the instrument using a raw TCP/IP connection with required newline termination
rm = pyvisa.ResourceManager()
instr = rm.open_resource(’TCPIP::[YOUR_INSTRUMENT_IP]::5025::SOCKET’)
instr.read_termination = ’\n’

# Query the packed waveform data
data = instr.query_binary_values(’CHAN1:DATA:PACK? ALL,RAW’, datatype=’B’)

# Define the struct format for the 32-byte metadata
metadata_format = ’fffIIffI’ # Corresponds to TimeDelta, StartTime, EndTime, etc.
metadata_size = struct.calcsize(metadata_format)

# Extract the first 32 bytes of metadata from the data
metadata_bytes = bytes(data[:metadata_size]) # Convert the metadata part to a byte string
metadata = struct.unpack(metadata_format, metadata_bytes)

# Assign metadata to meaningful variable names
(TimeDelta, StartTime, EndTime, SampleStart, SampleLength,
VerticalStart, VerticalLength, SampleCount) = metadata

# Print parsed metadata
print(f"Metadata")
print(f" TimeDelta = {TimeDelta}")
print(f" StartTime = {StartTime}")
print(f" EndTime = {EndTime}")
print(f" SampleStart = {SampleStart}")
print(f" SampleLength = {SampleLength}")
print(f" VerticalStart = {VerticalStart}")
print(f" VerticalLength = {VerticalLength}")
print(f" SampleCount = {SampleCount}")

# Extract samples starting from byte 33 onwards (after metadata) and convert into 16-bit uint
waveform_data_bytes = data[metadata_size:]
waveform_data = np.frombuffer(bytes(waveform_data_bytes), dtype=np.uint16)

# Normalize sample values based on VerticalStart and VerticalLength
amplitude_data = VerticalStart + (waveform_data / (SampleLength - 1)) * VerticalLength

# Create the timebase
timebase = np.linspace(StartTime, EndTime, len(amplitude_data), endpoint=True)

plt.plot(timebase, amplitude_data)
plt.xlabel(’Time in s’)
plt.ylabel(’Amplitude in V’)
plt.title(’Waveform’)
plt.show()
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2.3 Waveform Plot using the REST API
In this example, waveform data is queried in packed format using the default parameters ALL and V. Unlike
the raw socket example, the metadata is stored in separate JSON fields.

#!/usr/bin/python3

import matplotlib.pyplot as plt
import numpy as np
import requests

# Query the packed data with a POST to the REST API and interpret the response as json
data = requests.post("http://[YOUR_INSTRUMENT_IP]:8080/scpi", json="CHAN1:DATA:PACK?").json()

TimeDelta = data["TimeDelta"]
StartTime = data["StartTime"]
EndTime = data["EndTime"]
SampleCount = data["SampleCount"]

# Print metadata
print(f"Metadata")
print(f" TimeDelta = {TimeDelta}")
print(f" StartTime = {StartTime}")
print(f" EndTime = {EndTime}")
print(f" SampleCount = {SampleCount}")

# The samples can be directly fetched from the response json object
y = data["Samples"]

# Create the timebase
x = np.linspace(data["StartTime"], data["EndTime"], len(y), endpoint=True)

plt.plot(x, y)
plt.xlabel(’Time in s’)
plt.ylabel(’Amplitude in V’)
plt.title(’Waveform’)
plt.show()
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2.4 FFT Plot using raw sockets
In this example, FFT bins are queried in packed format using the default parameter DBM.

#!/usr/bin/python3

import matplotlib.pyplot as plt
import numpy as np
import pyvisa
import struct

# Open the instrument using a raw TCP/IP connection with required newline termination
rm = pyvisa.ResourceManager()
instr = rm.open_resource(’TCPIP::[YOUR_INSTRUMENT_IP]::5025::SOCKET’)
instr.read_termination = ’\n’

# Query the packed waveform data
data = instr.query_binary_values(’FFT1:DATA:PACK?’, datatype=’B’)

# Define the struct format for the 12-byte metadata
metadata_format = ’ffI’ # Corresponds to BinFrequency, StopFrequency and BinCount
metadata_size = struct.calcsize(metadata_format)

# Extract the first 12 bytes of metadata from the data
metadata_bytes = bytes(data[:metadata_size]) # Convert the metadata part to a byte string
metadata = struct.unpack(metadata_format, metadata_bytes)

# Assign metadata to meaningful variable names
BinFrequency, StopFrequency, BinCount = metadata

# Print parsed metadata
print(f"Metadata")
print(f" BinFrequency = {BinFrequency}")
print(f" StopFrequency = {StopFrequency}")
print(f" BinCount = {BinCount}")

# Extract bins starting from byte 13 onwards (after metadata) and convert into 32-bit floats
bins_bytes = data[metadata_size:]
bins = np.frombuffer(bytes(bins_bytes), dtype=np.float32)

# Create the frequency base
frequency_base = np.linspace(0, StopFrequency, len(bins), endpoint=True)

plt.plot(frequency_base, bins)
plt.xlabel(’Frequency in Hz’)
plt.ylabel(’Amplitude in dBm’)
plt.title(’FFT’)
plt.show()
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2.5 Measurement using raw sockets
In this example, the VAMP measurement is queried for CHAN1.

#!/usr/bin/python3

import matplotlib.pyplot as plt
import numpy as np
import pyvisa
import struct

# Open the instrument using a raw TCP/IP connection with required newline termination
rm = pyvisa.ResourceManager()
instr = rm.open_resource(’TCPIP::[YOUR_INSTRUMENT_IP]::5025::SOCKET’)
instr.read_termination = ’\n’

# Query all statistics for the measurement
data = instr.query_binary_values(’MEAS:VAMP:ALL? CHAN1’, datatype=’B’)

# Define the struct format for the statistics
statistics_format = ’dddddI’
statistics_size = struct.calcsize(statistics_format)

# Unpack the statistics
statistics = struct.unpack(statistics_format, bytes(data))

# Assign statistics to meaningful variable names
(Current, Average, Maximum, Minimum, Deviation, Count) = statistics

# Print parsed statistics
print(f"Statistics")
print(f" Current = {Current}")
print(f" Average = {Average}")
print(f" Maximum = {Maximum}")
print(f" Minimum = {Minimum}")
print(f" Deviation = {Deviation}")
print(f" Count = {Count}")
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3 Commands and Queries
The following sections describe the various available SCPI commands and queries. For an in-depth explana-
tion of how these features work, please consult the Batronix Magnova© User Manual.

• Placeholders
Brackets ([ and ]) indicate placeholders that must be replaced with specific values, as outlined in the
corresponding sections. For example, :CHAN would be replaced with :CHAN2 to reference the second
analog channel. Detailed rules for replacing placeholders are provided in the relevant sections. When
multiple values are specified separated by /, one must be selected.

3.1 Common
The common commands declared mandatory by IEEE 488.2.

*CLS

*ESE

*ESE?

*ESR?

*IDN?

*OPC

*OPC?

*RST

*SRE

*SRE?

*STB

*STB?

*TST?

*WAI
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3.2 Control
This section focuses on controlling the state of waveform acquisition, including managing synchronization
with the acquisition of new records.

:RUN

:STOP

:SINGle

:FORCe

:AUTO <State>
Parameters

State

ON or 1
OFF or 0

:AUTO?
Returns

ON

OFF

:CLEar

:SEQuence:STOP

:SEQuence:WAIT? <Waveforms>
Parameters

Waveforms

Integer The number of records to wait for. Default 1

Returns

The actual number of records acquired while waitingThe actual number of records acquired while
waiting
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3.3 :ACQuire
This section covers the general configuration of waveform acquisition.

:ACQuire:MDEPth <Depth>
Returns the memory depth per analog channel and digital channel group. The digital channels 0-7 and 8-15
each form a group.

Parameters

Depth

AUTo
AFASt
Integer in pts

:ACQuire:MDEPth?
Sets the memory depth per analog channel and digital channel group. The digital channels 0-7 and 8-15
each form a group.

Returns

AUTo

AFASt

Integer in pts Changes to other parameters that explicitly or
implicitly activate channels also modify the mem-
ory depth per channel.

:ACQuire:TEXPansion <Expansion>
Parameters

Expansion

ON or 1
OFF or 0

:ACQuire:TEXPansion?
Returns

ON

OFF

:ACQuire:ROLLmode <Mode>
Parameters

Mode

ON or 1
OFF or 0
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:ACQuire:ROLLmode?
Returns

ON

OFF

:ACQuire:HRESolution <Resolution>
Parameters

Resolution

12
12.5
13
13.5
14
14.5
15
15.5
16

:ACQuire:HRESolution?
Returns

12

12.5

13

13.5

14

14.5

15

15.5

16

:ACQuire:RCLock <Clock>
Parameters

Clock

INTernal
EXTernal
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:ACQuire:RCLock?
Returns

INTernal

EXTernal

:ACQuire:RCOut <State>
Parameters

State

ON or 1
OFF or 0

:ACQuire:RCOut?
Returns

ON

OFF

:ACQuire:MODE <Mode>
Parameters

Mode

SAMPle
PDETect
AVERage

:ACQuire:MODE?
Returns

SAMPle

PDETect

AVERage

:ACQuire:AVERage <Average>
Parameters

Average

Integer

:ACQuire:AVERage?
Returns

Integer
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:ACQuire:SRATe?
Returns

Integer in pts/s
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3.4 :TIMebase
This section covers the configuration of the timebase.

:TIMebase:REFerence <Reference>
Parameters

Reference

CENTer
LEFT
RIGHt
TRIGger

:TIMebase:REFerence?
Returns

CENTer

LEFT

RIGHt

TRIGger

:TIMebase:OFFSet <Offset>
Parameters

Offset

Real in s

:TIMebase:OFFSet?
Returns

Real in s

:TIMebase:SCALe <Scale>
Parameters

Scale

Real in s

:TIMebase:SCALe?
Returns

Real in s
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3.5 :CHANnel
This section covers the configuration of analog channels.

• [N] has to be replaced with an analog channel index, for example: CHANnel1

:CHANnel:STATe <State>
Parameters

State

ON or 1
OFF or 0

:CHANnel:STATe?
Returns

ON

OFF

:CHANnel[N]:STATe <State>
Parameters

State

ON or 1
OFF or 0

:CHANnel[N]:STATe?
Returns

ON

OFF

:CHANnel[N]:TERMination <Termination>
Parameters

Termination

ON or 1
OFF or 0

:CHANnel[N]:TERMination?
Returns

ON

OFF
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:CHANnel[N]:COUPling <Coupling>
Parameters

Coupling

AC
DC

:CHANnel[N]:COUPling?
Returns

AC

DC

:CHANnel[N]:DESKew <Delay>
Parameters

Delay

Real in s

:CHANnel[N]:DESKew?
Returns

Real in s

:CHANnel[N]:DIVisor <Divisor>
Parameters

Divisor

Numerator/Denominator For example 1/100 or 20/5

:CHANnel[N]:DIVisor?
Returns

Numerator/Denominator For example 1/100 or 20/5

:CHANnel[N]:UNIT <Unit>
Parameters

Unit

V
A
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:CHANnel[N]:UNIT?
Returns

V

A

:CHANnel[N]:OFFSet <Offset>
Parameters

Offset

Real in V or A

:CHANnel[N]:OFFSet?
Returns

Real in V or A

:CHANnel[N]:SCALe <Scale>
Parameters

Scale

Real in V or A

:CHANnel[N]:SCALe?
Returns

Real in V or A
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3.6 :CHANnel[N]:DATA
This section focuses on the transfer of analog waveform data.

• [N] has to be replaced with an analog channel index, for example: CHANnel1

:CHANnel[N]:DATA:SOURce <Source>
Parameters

Source

SCReen
ALL

:CHANnel[N]:DATA:SOURce?
Returns

SCReen

ALL

:CHANnel[N]:DATA:TYPE <Type>
Parameters

Type

V
RAW

:CHANnel[N]:DATA:TYPE?
Returns

V

RAW

:CHANnel[N]:DATA:RECord <Record>
Parameters

Record

Integer Negative to start at the back, for example -1 is
the last record

:CHANnel[N]:DATA:RECord?
Returns

Integer Negative to start at the back, for example -1 is
the last record

:CHANnel[N]:DATA:TDELta?
Returns

Real in s
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:CHANnel[N]:DATA:STIMe?
Returns

Real in s

:CHANnel[N]:DATA:ETIMe?
Returns

Real in s

:CHANnel[N]:DATA:SSTart?
Returns

Integer

:CHANnel[N]:DATA:SLENgth?
Returns

Integer

:CHANnel[N]:DATA:VSTart?
Returns

Real in V

:CHANnel[N]:DATA:VLENgth?
Returns

Real in V

:CHANnel[N]:DATA:SAMPles?
See :CHANnel[N]:DATA:SOURce, :CHANnel[N]:DATA:TYPe and :CHANnel[N]:DATA:RECord
for parameterization.

Returns

Sample data See 3.6.1. The metadata can be queried
from the various :CHANnel[N]:DATA sub-
commands.
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:CHANnel[N]:DATA:PACKed? <Source>,<Type>,<Record>
:CHANnel[N]:DATA:SOURce, :CHANnel[N]:DATA:TYPe and :CHANnel[N]:DATA:RECord are
ignored and specified through the parameters instead.

Parameters

Source

SCReen
ALL Default

Type

V
RAW Default

Record

Integer See RECord. Default -1

Returns

Packed sample data See 3.6.2.

3.6.1 Analog Data Samples

All data in this section has a Block Data header (see 1.1.3).

Analog waveform samples in V N is implicitly defined through the Block Data header

Field
Count
(bytes)

Data Type Json/Xml Name

Samples 4 * N 4-byte floating-point Samples

Analog waveform samples as raw N is implicitly defined through the Block Data header

Field
Count
(bytes)

Data Type Json/Xml Name

Samples 2 * N 2-byte unsigned integer Samples
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3.6.2 Analog Data Packed

All data in this section has a Block Data header (see 1.1.3).

Analog waveform samples in V including a metadata header

Field
Count
(bytes)

Data Type Json/Xml Name

Time between
samples

4 4-byte floating-point TimeDelta

Time of the first
sample

4 4-byte floating-point StartTime

Time of the last
sample

4 4-byte floating-point EndTime

N = Number of
samples

4 4-byte unsigned integer SampleCount

Samples 4 * N 4-byte floating-point Samples

Analog waveform samples as raw including a metadata header

Field
Count
(bytes)

Data Type Json/Xml Name

Time between
samples

4 4-byte floating-point TimeDelta

Time of the first
sample

4 4-byte floating-point StartTime

Time of the last
sample

4 4-byte floating-point EndTime

Offset to the valid
part of the

sample value
4 4-byte unsigned integer SampleStart

Length of the
valid part of the
sample value

4 4-byte unsigned integer SampleLength

Voltage
associated with
the start of the
valid sample

value

4 4-byte floating-point VerticalStart

Voltage
associated with
the length of the

valid sample
value

4 4-byte unsigned integer VerticalLength

N = Number of
samples

4 4-byte unsigned integer SampleCount

Samples 2 * N 2-byte unsigned integer Samples
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3.7 :DIGital
This section covers the configuration of digital channels.

• [N] has to be replaced with a a digital channel index, for example: DIGital5

:DIGital:STATe <State>
Parameters

State

ON or 1
OFF or 0

:DIGital:RST

:DIGital:STATe?
Returns

ON

OFF

:DIGital[N]:STATe <State>
Parameters

State

ON or 1
OFF or 0

:DIGital[N]:STATe?
Returns

ON

OFF

:DIGital:THReshold[0to7/8to15] <Threshold>
Parameters

Threshold

Real in V

:DIGital:THReshold[0to7/8to15]?
Returns

Real in V



Batronix Innovative Tools. Excellent Service.

Batronix Magnova® SCPI Manual © 2024 by Batronix GmbH & Co. KG
24211 Preetz, Handelsweg 16, Germany / Tel. +49 4342 90786-0 / service@batronix.com / www.batronix.com 41

3.8 :TRIGger
This section covers the selection and configuration of the trigger.

:TRIGger:TYPE <Type>
Parameters

Type

EDGe
NEDGe
TIMeout
DELay
WINDow
PULSe
SLOPe
INTerval
SHOLd
RUNT
PATTern
DECode

:TRIGger:TYPE?
Returns

EDGe

NEDGe

TIMeout

DELay

WINDow

PULSe

SLOPe

INTerval

SHOLd

RUNT

PATTern

DECode
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:TRIGger:AOUT <State>
Parameters

State

ON or 1
OFF or 0

:TRIGger:AOUT?
Returns

ON

OFF
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3.9 :TRIGger:EDGe
This section covers the edge trigger.

:TRIGger:EDGe:SOURce <Source>
Parameters

Source

[Channel]

:TRIGger:EDGe:SOURce?
Returns

[Channel]

:TRIGger:EDGe:SLOPe <Slope>
Parameters

Slope

RISing
FALLing
BOTH
ALTernate

:TRIGger:EDGe:SLOPe?
Returns

RISing

FALLing

BOTH

ALTernate

:TRIGger:EDGe:LEVel <Level>
Parameters

Level

Real in V or A

:TRIGger:EDGe:LEVel?
Returns

Real in V or A
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:TRIGger:EDGe:LHYSteresis <Hysteresis>
Parameters

Hysteresis

Real in %

:TRIGger:EDGe:LHYSteresis?
Returns

Real in %
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3.10 :TRIGger:NEDGe
This section covers the nth-edge trigger.

:TRIGger:NEDGe:SOURce <Source>
Parameters

Source

[Channel]

:TRIGger:NEDGe:SOURce?
Returns

[Channel]

:TRIGger:NEDGe:SLOPe <Slope>
Parameters

Slope

RISing
FALLing

:TRIGger:NEDGe:SLOPe?
Returns

RISing

FALLing

:TRIGger:NEDGe:LEVel <Level>
Parameters

Level

Real in V or A

:TRIGger:NEDGe:LEVel?
Returns

Real in V or A

:TRIGger:NEDGe:IDLe <Idle>
Parameters

Idle

Idle in s
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:TRIGger:NEDGe:IDLe?
Returns

Real in s

:TRIGger:NEDGe:COUNt <Count>
Parameters

Count

Integer

:TRIGger:NEDGe:COUNt?
Returns

Integer

:TRIGger:NEDGe:LHYSteresis <Hysteresis>
Parameters

Hysteresis

Real in %

:TRIGger:NEDGe:LHYSteresis?
Returns

Real in %
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3.11 :TRIGger:TIMeout
This section covers the timeout trigger.

:TRIGger:TIMeout:SOURce <Source>
Parameters

Source

[Channel] ACLine is not valid

:TRIGger:TIMeout:SOURce?
Returns

[Channel]

:TRIGger:TIMeoutGe:SLOPe <Slope>
Parameters

Slope

RISing
FALLing

:TRIGger:TIMeout:SLOPe?
Returns

RISing

FALLing

:TRIGger:TIMeout:LEVel <Level>
Parameters

Level

Real in V or A

:TRIGger:TIMeout:LEVel?
Returns

Real in V or A

:TRIGger:TIMeout:TIME <Time>
Parameters

Time

Real in s
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:TRIGger:TIMeout:TIME?
Returns

Real in s

:TRIGger:TIMeout:LHYSteresis <Hysteresis>
Parameters

Hysteresis

Real in %

:TRIGger:TIMeout:LHYSteresis?
Returns

Real in %
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3.12 :TRIGger:DELay
This section covers the delay trigger.

:TRIGger:DELay:SOURce1 <Source>
Parameters

Source

[Channel]

:TRIGger:DELay:SOURce1?
Returns

[Channel]

:TRIGger:DELay:SLOPe1 <Slope>
Parameters

Slope

RISing
FALLing

:TRIGger:DELay:SLOPe1?
Returns

RISing

FALLing

:TRIGger:DELay:LEVel1 <Level>
Parameters

Level

Real in V or A

:TRIGger:DELay:LEVel1?
Returns

Real in V or A

:TRIGger:DELay:SOURce2 <Source>
Parameters

Source

[Channel]
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:TRIGger:DELay:SOURce2?
Returns

[Channel]

:TRIGger:DELay:SLOPe2 <Slope>
Parameters

Slope

RISing
FALLing

:TRIGger:DELay:SLOPe2?
Returns

RISing

FALLing

:TRIGger:DELay:LEVel2 <Level>
Parameters

Level

Real in V or A

:TRIGger:DELay:LEVel2?
Returns

Real in V or A

:TRIGger:DELay:TYPE <Type>
Parameters

Type

LTHan
GTHan
INSide
OUTSide
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:TRIGger:DELay:TYPE?
Returns

LTHan

GTHan

INSide

OUTSide

:TRIGger:DELay:THReshold <Threshold>
Parameters

Threshold

Real in s

:TRIGger:DELay:THReshold?
Returns

Real in s

:TRIGger:DELay:DURation:LOWer <Duration>
Parameters

Duration

Real in s

:TRIGger:DELay:DURation:LOWer?
Returns

Real in s

:TRIGger:DELay:DURation:UPPer <Duration>
Parameters

Duration

Real in s

:TRIGger:DELay:DURation:UPPer?
Returns

Real in s
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:TRIGger:DELay:LHYSteresis <Hysteresis>
Parameters

Hysteresis

Real in %

:TRIGger:DELay:LHYSteresis?
Returns

Real in %
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3.13 :TRIGger:WINDow
This section covers the window trigger.

:TRIGger:WINDow:SOURce <Source>
Parameters

Source

CHANnel[AnalogN]

:TRIGger:WINDow:SOURce?
Returns

CHANnel[AnalogN]

:TRIGger:WINDow:TYPe <Slope>
Parameters

Slope

ENTer
LEAVe

:TRIGger:WINDow:TYPe?
Returns

ENTer

LEAVe

:TRIGger:WINDow:LEVel1 <Level>
Parameters

Level

Real in V or A

:TRIGger:WINDow:LEVel1?
Returns

Real in V or A

:TRIGger:WINDow:LEVel2 <Level>
Parameters

Level

Real in V or A
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:TRIGger:WINDow:LEVel2?
Returns

Real in V or A

:TRIGger:WINDow:TIMing <Timing>
Parameters

Timing

NONe
LTHan
GTHan
INSide
OUTSide

:TRIGger:WINDow:TIMing?
Returns

NONe

LTHan

GTHan

INSide

OUTSide

:TRIGger:WINDow:THReshold <Threshold>
Parameters

Threshold

Real in s

:TRIGger:WINDow:THReshold?
Returns

Real in s

:TRIGger:WINDow:DURation:LOWer <Duration>
Parameters

Duration

Real in s

:TRIGger:WINDow:DURation:LOWer?
Returns

Real in s
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:TRIGger:WINDow:DURation:UPPer <Duration>
Parameters

Duration

Real in s

:TRIGger:WINDow:DURation:UPPer?
Returns

Real in s

:TRIGger:WINDow:LHYSteresis <Hysteresis>
Parameters

Hysteresis

Real in %

:TRIGger:WINDow:LHYSteresis?
Returns

Real in %
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3.14 :TRIGger:PULSe
This section covers the pulse trigger.

:TRIGger:PULSe:SOURce <Source>
Parameters

Source

[Channel]

:TRIGger:PULSe:SOURce?
Returns

[Channel]

:TRIGger:PULSe:POLarity <Polarity>
Parameters

Polarity

POSitive
NEGative

:TRIGger:PULSe:POLarity?
Returns

POSitive

NEGative

:TRIGger:PULSe:LEVel <Level>
Parameters

Level

Real in V or A

:TRIGger:PULSe:LEVel?
Returns

Real in V or A
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:TRIGger:PULSe:TIMing <Timing>
Parameters

Timing

LTHan
GTHan
INSide
OUTSide

:TRIGger:PULSe:TIMing?
Returns

LTHan

GTHan

INSide

OUTSide

:TRIGger:PULSe:THReshold <Threshold>
Parameters

Threshold

Real in s

:TRIGger:PULSe:THReshold?
Returns

Real in s

:TRIGger:PULSe:DURation:LOWer <Duration>
Parameters

Duration

Real in s

:TRIGger:PULSe:DURation:LOWer?
Returns

Real in s

:TRIGger:PULSe:DURation:UPPer <Duration>
Parameters

Duration

Real in s
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:TRIGger:PULSe:DURation:UPPer?
Returns

Real in s

:TRIGger:PULSe:LHYSteresis <Hysteresis>
Parameters

Hysteresis

Real in %

:TRIGger:PULSe:LHYSteresis?
Returns

Real in %
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3.15 :TRIGger:SLOPe
This section covers the slope trigger.

:TRIGger:SLOPe:SOURce <Source>
Parameters

Source

CHANnel[AnalogN]

:TRIGger:SLOPe:SOURce?
Returns

CHANnel[AnalogN]

:TRIGger:SLOPe:TYPe <Slope>
Parameters

Slope

RISing
FALLing

:TRIGger:SLOPe:TYPe?
Returns

RISing

FALLing

:TRIGger:SLOPe:LEVel1 <Level>
Parameters

Level

Real in V or A

:TRIGger:SLOPe:LEVel1?
Returns

Real in V or A

:TRIGger:SLOPe:LEVel2 <Level>
Parameters

Level

Real in V or A
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:TRIGger:SLOPe:LEVel2?
Returns

Real in V or A

:TRIGger:SLOPe:TIMing <Timing>
Parameters

Timing

LTHan
GTHan
INSide
OUTSide

:TRIGger:SLOPe:TIMing?
Returns

LTHan

GTHan

INSide

OUTSide

:TRIGger:SLOPe:THReshold <Threshold>
Parameters

Threshold

Real in s

:TRIGger:SLOPe:THReshold?
Returns

Real in s

:TRIGger:SLOPe:DURation:LOWer <Duration>
Parameters

Duration

Real in s

:TRIGger:SLOPe:DURation:LOWer?
Returns

Real in s
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:TRIGger:SLOPe:DURation:UPPer <Duration>
Parameters

Duration

Real in s

:TRIGger:SLOPe:DURation:UPPer?
Returns

Real in s

:TRIGger:SLOPe:LHYSteresis <Hysteresis>
Parameters

Hysteresis

Real in %

:TRIGger:SLOPe:LHYSteresis?
Returns

Real in %
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3.16 :TRIGger:INTerval
This section covers the interval trigger.

:TRIGger:INTerval:SOURce <Source>
Parameters

Source

[Channel]

:TRIGger:INTerval:SOURce?
Returns

[Channel]

:TRIGger:INTerval:POLarity <Polarity>
Parameters

Polarity

POSitive
NEGative

:TRIGger:INTerval:POLarity?
Returns

POSitive

NEGative

:TRIGger:INTerval:LEVel <Level>
Parameters

Level

Real in V or A

:TRIGger:INTerval:LEVel?
Returns

Real in V or A
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:TRIGger:INTerval:TIMing <Timing>
Parameters

Timing

LTHan
GTHan
INSide
OUTSide

:TRIGger:INTerval:TIMing?
Returns

LTHan

GTHan

INSide

OUTSide

:TRIGger:INTerval:THReshold <Threshold>
Parameters

Threshold

Real in s

:TRIGger:INTerval:THReshold?
Returns

Real in s

:TRIGger:INTerval:DURation:LOWer <Duration>
Parameters

Duration

Real in s

:TRIGger:INTerval:DURation:LOWer?
Returns

Real in s

:TRIGger:INTerval:DURation:UPPer <Duration>
Parameters

Duration

Real in s
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:TRIGger:INTerval:DURation:UPPer?
Returns

Real in s

:TRIGger:INTerval:LHYSteresis <Hysteresis>
Parameters

Hysteresis

Real in %

:TRIGger:INTerval:LHYSteresis?
Returns

Real in %
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3.17 :TRIGger:SHOLd
This section covers the setup-hold trigger.

:TRIGger:SHOLd:CLOCk:SOURce <Source>
Parameters

Source

[Channel]

:TRIGger:SHOLd:CLOCk:SOURce?
Returns

[Channel]

:TRIGger:SHOLd:CLOCk:SLOPe <Slope>
Parameters

Slope

RISing
FALLing

:TRIGger:SHOLd:CLOCk:SLOPe?
Returns

RISing

FALLing

:TRIGger:SHOLd:CLOCk:LEVel <Level>
Parameters

Level

Real in V or A

:TRIGger:SHOLd:CLOCk:LEVel?
Returns

Real in V or A

:TRIGger:SHOLd:CLOCk:HYSTeresis <Hysteresis>
Parameters

Hysteresis

Real in %
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:TRIGger:SHOLd:CLOCk:HYSTeresis?
Returns

Real in %

:TRIGger:SHOLd:DATA:SOURce <Source>
Parameters

Source

[Channel]

:TRIGger:SHOLd:DATA:SOURce?
Returns

[Channel]

:TRIGger:SHOLd:DATA:LEVel <Level>
Parameters

Level

Real in V or A

:TRIGger:SHOLd:DATA:LEVel?
Returns

Real in V or A

:TRIGger:SHOLd:DATA:HYSTeresis <Hysteresis>
Parameters

Hysteresis

Real in %

:TRIGger:SHOLd:DATA:HYStTeresis?
Returns

Real in %

:TRIGger:SHOLd:TYPe <Type>
Parameters

Type

HOLD
SETup
SHOLd
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:TRIGger:SHOLd:TYPe?
Returns

HOLD

SETup

SHOLd

:TRIGger:SHOLd:STIMe <Time>
Parameters

Time

Real in s

:TRIGger:SHOLd:STIMe?
Returns

Real in s

:TRIGger:SHOLd:HTIMe <Time>
Parameters

Time

Real in s

:TRIGger:SHOLd:HTIMe?
Returns

Real in s
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3.18 :TRIGger:RUNT
This section covers the runt trigger.

:TRIGger:RUNT:SOURce <Source>
Parameters

Source

CHANnel[AnalogN]

:TRIGger:RUNT:SOURce?
Returns

CHANnel[AnalogN]

:TRIGger:RUNT:POLarity <Polarity>
Parameters

Polarity

POSitive
NEGative

:TRIGger:RUNT:POLarity?
Returns

POSitive

NEGative

:TRIGger:RUNT:LEVel1 <Level>
Parameters

Level

Real in V or A

:TRIGger:RUNT:LEVel1?
Returns

Real in V or A

:TRIGger:RUNT:LEVel2 <Level>
Parameters

Level

Real in V or A
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:TRIGger:RUNT:LEVel2?
Returns

Real in V or A

:TRIGger:RUNT:TIMing <Timing>
Parameters

Timing

NONe
LTHan
GTHan
INSide
OUTSide

:TRIGger:RUNT:TIMing?
Returns

NONe

LTHan

GTHan

INSide

OUTSide

:TRIGger:RUNT:THReshold <Threshold>
Parameters

Threshold

Real in s

:TRIGger:RUNT:THReshold?
Returns

Real in s

:TRIGger:RUNT:DURation:LOWer <Duration>
Parameters

Duration

Real in s

:TRIGger:RUNT:DURation:LOWer?
Returns

Real in s
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:TRIGger:RUNT:DURation:UPPer <Duration>
Parameters

Duration

Real in s

:TRIGger:RUNT:DURation:UPPer?
Returns

Real in s

:TRIGger:RUNT:LHYSteresis <Hysteresis>
Parameters

Hysteresis

Real in %

:TRIGger:RUNT:LHYSteresis?
Returns

Real in %
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3.19 :TRIGger:PATTern
This section covers the pattern trigger.

:TRIGger:PATTern:TYPE <Timing>
Parameters

Timing

AND
OR
NAND
NOR

:TRIGger:PATTern:TYPE?
Returns

ND

OR

NAND

NOR

:TRIGger:PATTern:TIMing <Timing>
Parameters

Timing

NONe
LTHan
GTHan
INSide
OUTSide

:TRIGger:PATTern:TIMing?
Returns

NONe

LTHan

GTHan

INSide

OUTSide
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:TRIGger:PATTern:THReshold <Threshold>
Parameters

Threshold

Real in s

:TRIGger:PATTern:THReshold?
Returns

Real in s

:TRIGger:PATTern:DURation:LOWer <Duration>
Parameters

Duration

Real in s

:TRIGger:PATTern:DURation:LOWer?
Returns

Real in s

:TRIGger:PATTern:DURation:UPPer <Duration>
Parameters

Duration

Real in s

:TRIGger:PATTern:DURation:UPPer?
Returns

Real in s

:TRIGger:PATTern:[Channel]:CLOCk <State>
Parameters

State

ON or 1
OFF or 0

:TRIGger:PATTern:[Channel]:CLOCk?
Returns

ON

OFF
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:TRIGger:PATTern:[Channel]:PATTern <Pattern>
Parameters

Pattern

IGNore
HIGH
LOW

:TRIGger:PATTern:[Channel]:PATTern?
Returns

IGNore

HIGH

LOW

:TRIGger:PATTern:[Channel]:THReshold:LOWer <Duration>
Parameters

Duration

Real in V or A

:TRIGger:PATTern:[Channel]:THReshold:LOWer?
Returns

Real in V or A

:TRIGger:PATTern:[Channel]:THReshold:UPPer <Duration>
Parameters

Duration

Real in V or A

:TRIGger:PATTern:[Channel]:THReshold:UPPer?
Returns

Real in V or A

:TRIGger:PATTern:CLOCk:SOURce <Source>
Parameters

Source

[Channel] CLine is not valid
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:TRIGger:PATTern:CLOCk:SOURce?
Returns

[Channel]

:TRIGger:PATTern:CLOCk:SLOPe <Slope>
Parameters

Slope

RISing
FALLing

:TRIGger:PATTern:CLOCk:SLOPe?
Returns

RISing

FALLing

:TRIGger:PATTern:CLOCk:LEVel <Level>
Parameters

Level

Real in V or A

:TRIGger:PATTern:CLOCk:LEVel?
Returns

Real in V or A

:TRIGger:PATTern:CLOCk:HYSTeresis <Hysteresis>
Parameters

Hysteresis

Real in %

:TRIGger:PATTern:CLOCk:HYSTeresis?
Returns

Real in %
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3.20 :TRIGger:DECode
This section covers the selection of the decode group as trigger source and the configuration of bus-specific
trigger settings.

:TRIGger:DECode:GROup <GROup>
Parameters

GROup

DECode[DecodeN]

:TRIGger:DECode:GROup?
Returns

DECode[DecodeN]
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3.21 :TRIGger:DECode:I2C
This section covers the I2C decode trigger.

• [ByteN] has to be replaced with a byte index, for example: BYTE4

:TRIGger:DECode:I2C:EVENt <Event>
Parameters

Event

STARt
STOP
RESTart
ACK
NACK
ADDRess
DATa
ADATa

:TRIGger:DECode:I2C:EVENt?
Returns

STARt

STOP

RESTart

ACK

NACK

ADDRess

DATa

ADATa

:TRIGger:DECode:I2C:ADDRess:NFORmat <Format>
Parameters

Format

DEC
HEX
BIN
ASCii
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:TRIGger:DECode:I2C:ADDRess:NFORmat?
Returns

DEC

HEX

BIN

ASCii

:TRIGger:DECode:I2C:ADDRess:LENGth <Length>
Parameters

Length

AUTo
7
10

:TRIGger:DECode:I2C:ADDRess:LENGth?
Returns

AUTo

7

10

:TRIGger:DECode:I2C:ADDRess:DIRection <Direction>
Parameters

Direction

READ
WRITe
RWRite

:TRIGger:DECode:I2C:ADDRess:DIRection?
Returns

READ

WRITe

RWRite

:TRIGger:DECode:I2C:ADDRess:WORD <Word>
Parameters

Word

Integer/String In :TRIGger:DECode:I2C:ADDRess:NFORmat
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:TRIGger:DECode:I2C:ADDRess:WORD?
Returns

Integer/String In :TRIGger:DECode:I2C:ADDRess:NFORmat

:TRIGger:DECode:I2C:DATA:NFORmat <Format>
Parameters

Format

DEC
HEX
BIN
ASCii

:TRIGger:DECode:I2C:DATA:NFORmat?
Returns

DEC

HEX

BIN

ASCii

:TRIGger:DECode:I2C:DATA:POSition <Position>
Parameters

Position

OFFSet
ANYWhere

:TRIGger:DECode:I2C:DATA:POSition?
Returns

OFFSet

ANYWhere

:TRIGger:DECode:I2C:DATA:OFFSet <Offset>
Parameters

Offset

Integer in bytes
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:TRIGger:DECode:I2C:DATA:OFFSet?
Returns

Integer in bytes

:TRIGger:DECode:I2C:DATA:LENGth <Length>
Parameters

Length

Integer in bytes

:TRIGger:DECode:I2C:DATA:LENGth?
Returns

Integer in bytes

:TRIGger:DECode:I2C:DATA:BYTE[ByteN] <Byte>
Parameters

Byte

Integer/String In :TRIGger:DECode:I2C:DATA:NFORmat

:TRIGger:DECode:I2C:DATA:BYTE[ByteN]?
Returns

Integer/String In :TRIGger:DECode:I2C:DATA:NFORmat



Batronix Innovative Tools. Excellent Service.

Batronix Magnova® SCPI Manual © 2024 by Batronix GmbH & Co. KG
24211 Preetz, Handelsweg 16, Germany / Tel. +49 4342 90786-0 / service@batronix.com / www.batronix.com 80

3.22 :TRIGger:DECode:SPI
This section covers the SPI decode trigger.

• [WordN] has to be replaced with a word index, for example: WORD1

:TRIGger:DECode:SPI:LANE <Lane>
Parameters

Lane

MOSi
MISo

:TRIGger:DECode:SPI:LANE?
Returns

MOSi

MISo

:TRIGger:DECode:SPI:ALIGnment <Alignment>
Parameters

Alignment

BIT
WORD

:TRIGger:DECode:SPI:ALIGnment?
Returns

BIT

WORD

:TRIGger:DECode:SPI:DATA:POSition <Position>
Parameters

Position

OFFSet
ANYWhere

:TRIGger:DECode:SPI:DATA:POSition?
Returns

OFFSet

ANYWhere
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:TRIGger:DECode:SPI:DATA:NFORmat <Format>
Parameters

Format

DEC
HEX
BIN
ASCii

:TRIGger:DECode:SPI:DATA:NFORmat?
Returns

DEC

HEX

BIN

ASCii

:TRIGger:DECode:SPI:DATA:WORDs:OFFSet <Offset>
Parameters

Offset

Integer in words

:TRIGger:DECode:SPI:DATA:WORDs:OFFSet?
Returns

Integer in words

:TRIGger:DECode:SPI:DATA:WORDs:LENGth <Length>
Parameters

Length

Integer in words

:TRIGger:DECode:SPI:DATA:WORDs:LENGth?
Returns

Integer in words

:TRIGger:DECode:SPI:DATA:WORD[WordN] <Word>
Parameters

Word

Integer/String In :TRIGger:DECode:SPI:DATA:NFORmat
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:TRIGger:DECode:SPI:DATA:WORD[WordN]?
Returns

Integer/String In :TRIGger:DECode:SPI:DATA:NFORmat

:TRIGger:DECode:SPI:DATA:BITS:OFFSet <Offset>
Parameters

Offset

Integer in bits

:TRIGger:DECode:SPI:DATA:BITS:OFFSet?
Returns

Integer in bits

:TRIGger:DECode:SPI:DATA:BITS:LENGth <Length>
Parameters

Length

Integer in bits

:TRIGger:DECode:SPI:DATA:BITS:LENGth?
Returns

Integer in bits

:TRIGger:DECode:SPI:DATA:BITS <Bits>
Parameters

Bits

Integer/String In :TRIGger:DECode:SPI:DATA:NFORmat

:TRIGger:DECode:SPI:DATA:BITS?
Returns

Integer/String In :TRIGger:DECode:SPI:DATA:NFORmat
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3.23 :TRIGger:DECode:UART
This section covers the UART decode trigger.

• [WordN] has to be replaced with a word index, for example: WORD3

:TRIGger:DECode:UART:EVENt <Event>
Parameters

Event

FSTart
IFSTart
FPCHeck
IFCompletion
DATa

:TRIGger:DECode:UART:EVENt?
Returns

FSTart

IFSTart

FPCHeck

IFCompletion

DATa

:TRIGger:DECode:UART:DATA:POSition <Position>
Parameters

Position

OFFSet
ANYWhere

:TRIGger:DECode:UART:DATA:POSition?
Returns

OFFSet

ANYWhere

:TRIGger:DECode:UART:DATA:OFFSet <Offset>
Parameters

Offset

Integer in words
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:TRIGger:DECode:UART:DATA:OFFSet?
Returns

Integer in words

:TRIGger:DECode:UART:DATA:LENGth <Length>
Parameters

Length

Integer in words

:TRIGger:DECode:UART:DATA:LENGth?
Returns

Integer in words

:TRIGger:DECode:UART:DATA:PARity <Parity>
Parameters

Parity

IGNore
MATCh
MISMatch

:TRIGger:DECode:UART:DATA:PARity?
Returns

IGNore

MATCh

MISMatch

:TRIGger:DECode:UART:DATA:NFORmat <Format>
Parameters

Format

DEC
HEX
BIN
ASCii
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:TRIGger:DECode:UART:DATA:NFORmat?
Returns

DEC

HEX

BIN

ASCii

:TRIGger:DECode:UART:DATA:WORD[WordN] <Word>
Parameters

Word

Integer/String In :TRIGger:DECode:UART:DATA:NFORmat

:TRIGger:DECode:UART:DATA:WORD[WordN]?
Returns

Integer/String In :TRIGger:DECode:UART:DATA:NFORmat
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3.24 :TRIGger:DECode:PARallel
This section covers the parallel decode trigger.

• [WordN] has to be replaced with a word index, for example: WORD2

:TRIGger:DECode:PARallel:NFORmat <Format>
Parameters

Format

DEC
HEX
BIN
ASCii

:TRIGger:DECode:PARallel:NFORmat?
Returns

DEC

HEX

BIN

ASCii

:TRIGger:DECode:PARallel:WORD[WordN] <Word>
Parameters

Word

Integer/String In :TRIGger:DECode:PARallel:NFORmat

:TRIGger:DECode:PARallel:WORD[WordN]?
Returns

Integer/String In :TRIGger:DECode:PARallel:NFORmat
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3.25 :MEASurement
This section covers the general measurement configuration, as well as adding, removing and configuring
specific measurements. Measurement statistics can also be queried.

• [AnalogN] has to be replaced with an analog channel index, for example: CHANnel1

• [Channel] has to be replaced with an analog or digital channel, for example: CHANnel1 or DIGi-
tal7

• [Type] has to be replaced with one of the measurements at the end of this section, see 3.25.2.

:MEASurement:STATe <State>
Parameters

State

ON or 1
OFF or 0

:MEASurement:STATe?
Returns

ON

OFF

:MEASurement:DISPlay <Display>
Parameters

Display

COMPact
DETailed

:MEASurement:DISPlay?
Returns

COMPact

DETailed

:MEASurement:GATE <Gate>
Parameters

Gate

SCReen
AREa

:MEASurement:GATE?
Returns

SCReen

AREa
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:MEASurement:ATYPe <Type>
Parameters

Type

FIXed
RUNNing

:MEASurement:ATYPe?
Returns

FIXed

RUNNing

:MEASurement:AVERage <Average>
Parameters

Average

Integer

:MEASurement:AVERage?
Returns

Integer

:MEASurement:RLEVels:CHANnel[AnalogN]:BASE <Level>
Parameters

Level

VPP
VAMP
MANual

:MEASurement:RLEVels:CHANnel[AnalogN]:BASE?
Returns

VPP

VAMP

MANual

:MEASurement:RLEVels:CHANnel[AnalogN]:VPP:LOWer <Level>
Parameters

Level

Real in %



Batronix Innovative Tools. Excellent Service.

Batronix Magnova® SCPI Manual © 2024 by Batronix GmbH & Co. KG
24211 Preetz, Handelsweg 16, Germany / Tel. +49 4342 90786-0 / service@batronix.com / www.batronix.com 89

:MEASurement:RLEVels:CHANnel[AnalogN]:VPP:LOWer?
Returns

Real in %

:MEASurement:RLEVels:CHANnel[AnalogN]:VPP:MID <Level>
Parameters

Level

Real in %

:MEASurement:RLEVels:CHANnel[AnalogN]:VPP:MID?
Returns

Real in %

:MEASurement:RLEVels:CHANnel[AnalogN]:VPP:UPPer <Level>
Parameters

Level

Real in %

:MEASurement:RLEVels:CHANnel[AnalogN]:VPP:UPPer?
Returns

Real in %

:MEASurement:RLEVels:CHANnel[AnalogN]:VAMPP:LOWer <Level>
Parameters

Level

Real in %

:MEASurement:RLEVels:CHANnel[AnalogN]:VAMP:LOWer?
Returns

Real in %

:MEASurement:RLEVels:CHANnel[AnalogN]:VAMP:MID <Level>
Parameters

Level

Real in %
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:MEASurement:RLEVels:CHANnel[AnalogN]:VAMP:MID?
Returns

Real in %

:MEASurement:RLEVels:CHANnel[AnalogN]:VAMP:UPPer <Level>
Parameters

Level

Real in %

:MEASurement:RLEVels:CHANnel[AnalogN]:VAMP:UPPer?
Returns

Real in %

:MEASurement:RLEVels:CHANnel[AnalogN]:MANual:LOWer <Level>
Parameters

Level

Real in %

:MEASurement:RLEVels:CHANnel[AnalogN]:MANual:LOWer?
Returns

Real in V

:MEASurement:RLEVels:CHANnel[AnalogN]:MANual:MID <Level>
Parameters

Level

Real in V

:MEASurement:RLEVels:CHANnel[AnalogN]:MANual:MID?
Returns

Real in V

:MEASurement:RLEVels:CHANnel[AnalogN]:MANual:UPPer <Level>
Parameters

Level

Real in V
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:MEASurement:RLEVels:CHANnel[AnalogN]:MANual:UPPer?
Returns

Real in V

:MEASurement:CLEar

:MEASurement:[Type]:ALL? <Type>
Parameters

Type

[Channel]
[Channel],[Channel] For Delay and Phase

Returns

Packed statistics See 3.25.1.

:MEASurement:[Type]:CURRent? <Type>
Parameters

Type

[Channel]
[Channel],[Channel] For Delay and Phase

:MEASurement:[Type]:AVERage? <Type>
Parameters

Type

[Channel]
[Channel],[Channel] For Delay and Phase

:MEASurement:[Type]:MAXimum? <Type>
Parameters

Type

[Channel]
[Channel],[Channel] For Delay and Phase

:MEASurement:[Type]:MINimum? <Type>
Parameters

Type

[Channel]
[Channel],[Channel] For Delay and Phase
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:MEASurement:[Type]:DEViation? <Type>
Parameters

Type

[Channel]
[Channel],[Channel] For Delay and Phase

:MEASurement:[Type]:COUNt? <Type>
Parameters

Type

[Channel]
[Channel],[Channel] For Delay and Phase

:MEASurement:[Type]:ADD

:MEASurement:[Type]:REMove

3.25.1 All measurement statistics

All data in this section has a Block Data header (see 1.1.3).

The measurement statistics

Field
Count
(bytes)

Data Type Json/Xml Name

Current 8 8-byte floating-point Current

Average 8 8-byte floating-point Average

Maximum 8 8-byte floating-point Maximum

Minimum 8 8-byte floating-point Minimum

Deviation 8 8-byte floating-point Deviation

Count 4 4-byte integer Count

3.25.2 Measurement Types

The available measurement types.

• VMIN Vmin

• VMAX Vmax

• VPP Vpp

• VBASe Vbase

• VTOP Vtop

• VAMP Vamp

• VLOWer Vlower

• VUPPer Vupper



Batronix Innovative Tools. Excellent Service.

Batronix Magnova® SCPI Manual © 2024 by Batronix GmbH & Co. KG
24211 Preetz, Handelsweg 16, Germany / Tel. +49 4342 90786-0 / service@batronix.com / www.batronix.com 93

• VMID Vmid

• VAVG Vavg

• VRMS Vrms

• VSDeviation Std. Dev

• VPPReshoot +Preshoot

• VNPReshoot -Preshoot

• VPOVershoot +Overshoot

• VNOVershoot -Overshoot

• VPARea +Area

• VNARea -Area

• VAARea |Area|

• VNAArea Area

• VPPArea +Per. Area

• VNPArea -Per. Area

• VAPArea |Per. Area|

• VNAPArea Per. Area

• HRTime Trise

• HFTime Tfall

• HPERiod Period

• HFReq Freq

• HHWidth +Width

• HLWidth -Width

• HHDuty +Duty

• HLDuty -Duty

• RECount +Edge#

• FECount -Edge#

• PPCount +Pulse#

• NPCount -Pulse#

• HDELay:[RISing/FALLing]:[RISing/FALLing]:[NEARest/FORWard/BACKward]
[+/-][+/-]Delay[[None]/>/<]

• HPHase:[RISing/FALLing]:[RISing/FALLing]:[NEARest/FORWard/BACKward]
[+/-][+/-]Phase[[None]/>/<]



Batronix Innovative Tools. Excellent Service.

Batronix Magnova® SCPI Manual © 2024 by Batronix GmbH & Co. KG
24211 Preetz, Handelsweg 16, Germany / Tel. +49 4342 90786-0 / service@batronix.com / www.batronix.com 94

3.26 :REFerence
This section covers adding, removing and configuring references.

• [N] has to be replaced with a reference index, for example: REFerence2

• References are automatically created when a setting is changed for a non-existent channel.

:REFerence:STATe <State>
Parameters

State

ON or 1
OFF or 0

:REFerence:STATe?
Returns

ON

OFF

:REFerence:CLEar

:REFerence[N]:STATe <State>
Parameters

State

ON or 1
OFF or 0

:REFerence[N]:STATe?
Returns

ON

OFF

:REFerence[N]:SOURce <Source>
Parameters

Source

CHANnel[AnalogN]

:REFerence[N]:SOURce?
Returns

CHANnel[AnalogN]
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:REFerence[N]:OFFSet <Offset>
Parameters

Offset

Real in V or A

:REFerence[N]:OFFSet?
Returns

Real in V or A

:REFerence[N]:SCALe <Scale>
Parameters

Scale

Real in V or A

:REFerence[N]:SCALe?
Returns

Real in V or A

:REFerence[N]:REFResh

:REFerence[N]:ADD

:REFerence[N]:REMove
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3.27 :MATH
This section covers adding, removing and configuring math channels.

• [N] has to be replaced with a math channel index, for example: MATH1

• Math channels are automatically added when a setting is changed for a non-existent channel.

:MATH:STATe <State>
Parameters

State

ON or 1
OFF or 0

:MATH:STATe?
Returns

ON

OFF

:MATH:CLEar

:MATH[N]:STATe <State>
Parameters

State

ON or 1
OFF or 0

:MATH[N]:STATe?
Returns

ON

OFF

:MATH[N]:UNIT <Unit>
Parameters

Unit

String

:MATH[N]:UNIT?
Returns

String



Batronix Innovative Tools. Excellent Service.

Batronix Magnova® SCPI Manual © 2024 by Batronix GmbH & Co. KG
24211 Preetz, Handelsweg 16, Germany / Tel. +49 4342 90786-0 / service@batronix.com / www.batronix.com 97

:MATH[N]:EXPRession <Expression>
Parameters

Expression

String Mathematical expression

:MATH[N]:EXPRession?
Returns

String Mathematical expression

:MATH[N]:OFFSet <Offset>
Parameters

Offset

Real in any unit

:MATH[N]:OFFSet?
Returns

Real

:MATH[N]:SCALe <Scale>
Parameters

Scale

Real in any unit

:MATH[N]:SCALe?
Returns

Real

:MATH[N]:ADD

:MATH[N]:REMove
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3.28 :FFT
This section covers the configuration of general FFT settings and FFT channels.

• [N] has to be replaced with an FFT channel index, for example: FFT2

• [AnalogN] has to be replaced with an analog channel index, for example: CHANnel1

:FFT:STATe <State>
Parameters

State

ON or 1
OFF or 0

:FFT:STATe?
Returns

ON

OFF

:FFT:SCALe <Scale>
Parameters

Scale

DBM
DBV
DBMV
DBUV
V

:FFT:SCALe?
Returns

DBM

DBV

DBMV

DBUV

V

:FFT:FREQuency:CENTer <Center>
Parameters

Center

Real in Hz
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:FFT:FREQuency:CENTer?
Returns

Real in Hz

:FFT:FREQuency:SPAN <Span>
Parameters

Span

Real in Hz

:FFT:FREQuency:SPAN?
Returns

Real in Hz

:FFT:FREQuency:STARt <Start>
Parameters

Start

Real in Hz

:FFT:FREQuency:STARt?
Returns

Real in Hz

:FFT:FREQuency:STOP <Stop>
Parameters

Stop

Real in Hz

:FFT:FREQuency:STOP?
Returns

Real in Hz

:FFT[N]:STATe <State>
Parameters

State

ON or 1
OFF or 0
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:FFT[N]:STATe?
Returns

ON

OFF

:FFT[N]:SOURce <Source>
Parameters

Source

CHANnel[AnalogN]

:FFT[N]:SOURce?
Returns

CHANnel[AnalogN]

:FFT[N]:WINDow <Window>
Parameters

Window

RECTangle
HANN
HAMMing
BLACkman
FLATtop
GAUSsian
KBESsel

:FFT[N]:WINDow?
Returns

RECTangle

HANN

HAMMing

BLACkman

FLATtop

GAUSsian

KBESsel
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:FFT[N]:TRACe <Trace>
Parameters

Trace

SPECtrum
AVERage
MINHold
MAXHold

:FFT[N]:TRACe?
Returns

SPECtrum

AVERage

MINHold

MAXHold

:FFT[N]:AVERage <Average>
Parameters

Average

Integer

:FFT[N]:AVERage?
Returns

Integer

:FFT[N]:OFFSet <Offset>
Parameters

Offset

Real in unit See :FFT:SCALe for units

:FFT[N]:OFFSet?
Returns

Real in unit See :FFT:SCALe for units

:FFT[N]:SCALe <Scale>
Parameters

Scale

Real in unit See :FFT:SCALe for units
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:FFT[N]:SCALe?
Returns

Real in unit See :FFT:SCALe for units
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3.29 :FFT[N]:DATA
This section focuses on the transfer of FFT bins.

• [N] has to be replaced with an FFT channel index, for example: FFT2

:FFT[N]:DATA:SCALe <Scale>
Parameters

Scale

DBM
DBV
DBMV
DBUV
V

:FFT[N]:DATA:SCALe?
Returns

DBM

DBV

DBMV

DBUV

V

:FFT[N]:DATA:BFRequency?
Returns

Real in Hz

:FFT[N]:DATA:SFRequency?
Returns

Real in Hz

:FFT[N]:DATA:BINS
See :FFT[N]:DATA:SCALe for parameterization.

Returns

Bin data See 3.29.1. The metadata can be queried
from :FFT[N]:DATA:BFRequency and
:FFT[N]:DATA:SFRequency.
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:CHANnel[N]:DATA:PACKed? <Scale>
:FFT[N]:DATA:SCALe is ignored and specified through the parameter instead.

Parameters

Scale

DBM Default

DBV
DBMV
DBUV
V

Returns

Packed bin data See 3.29.2.

3.29.1 FFT Data Bins

All data in this section has a Block Data header (see 1.1.3).

The FFT bins N is implicitly defined through the Block Data header

Field
Count
(bytes)

Data Type Json/Xml Name

Bins 4 * N 4-byte floating-point Bins

3.29.2 FFT Data Packed

All data in this section has a Block Data header (see 1.1.3).

The FFT bins including a metadata header

Field
Count
(bytes)

Data Type Json/Xml Name

The bin frequency 4 4-byte floating-point BinFrequency

Frequency of the
last bin

4 4-byte floating-point StopFrequency

N = Number of
bins

4 4-byte unsigned integer BinCount

Bins 4 * N 4-byte floating-point Bins
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3.30 :FFT:PTABle
This section covers the configuration of the FFT peak table.

• [N] has to be replaced with an FFT channel index, for example: FFT3

• [PeakN] has to be replaced with a peak table index, for example: PTABle1

:FFT:PTABle:STATe <State>
Parameters

State

ON or 1
OFF or 0

:FFT:PTABle:STATe?
Returns

ON

OFF

:FFT:PTABle[PeakN]:STATe <State>
Parameters

State

ON or 1
OFF or 0

:FFT:PTABle[PeakN]:STATe?
Returns

ON

OFF

:FFT:PTABle[PeakN]:SOURce <Source>
Parameters

Source

FFT[N]

:FFT:PTABle[PeakN]:SOURce?
Returns

FFT[N]
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:FFT:PTABle[PeakN]:FRANge <Range>
Parameters

Range

COMPlete
SPAN

:FFT:PTABle[PeakN]:FRANge?
Returns

COMPlete

SPAN

:FFT:PTABle[PeakN]:TYPE <Type>
Parameters

Type

MINimum
MAXimum

:FFT:PTABle[PeakN]:TYPE?
Returns

MINimum

MAXimum

:FFT[N]:PTABle[PeakN]:EXCursion <Excursion>
Parameters

Excursion

Real in unit See :FFT:SCALe for units

:FFT[N]:PTABle[PeakN]:EXCursion?
Returns

Real in unit See :FFT:SCALe for units

:FFT[N]:PTABle[PeakN]:THReshold <Threshold>
Parameters

Threshold

Real in unit See :FFT:SCALe for units
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:FFT[N]:PTABle[PeakN]:THReshold?
Returns

Real in unit See :FFT:SCALe for units

:FFT[N]:PTABle[PeakN]:PEAKs
Returns

Peak data See 3.30.1.
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3.30.1 FFT Peak Data

All data in this section has a Block Data header (see 1.1.3).

The FFT peaks N is implicitly defined through the Block Data header

Field
Count
(bytes)

Data Type Json/Xml Name

Peaks (Frequency
/ Amplitude)

2 * 8 * N
8-byte floating-point / 8-byte

floating-point
Frequency / Amplitude



Batronix Innovative Tools. Excellent Service.

Batronix Magnova® SCPI Manual © 2024 by Batronix GmbH & Co. KG
24211 Preetz, Handelsweg 16, Germany / Tel. +49 4342 90786-0 / service@batronix.com / www.batronix.com 109

3.31 :FFT:SPECtrogram
This section covers the configuration of the FFT spectrogram.

• [N] has to be replaced with an FFT channel index, for example: FFT4

:FFT:SPECtrogram:STATe <State>
Parameters

State

ON or 1
OFF or 0

:FFT:SPECtrogram:STATe?
Returns

ON

OFF

:FFT:SPECtrogram:SOURce <Source>
Parameters

Source

FFT[N]

:FFT:SPECtrogram:SOURce?
Returns

FFT[N]

:FFT:SPECtrogram:THReshold:LOWer <Threshold>
Parameters

Threshold

Real in unit See :FFT:SCALe for units

:FFT:SPECtrogram:THReshold:LOWer?
Returns

Real in unit See :FFT:SCALe for units

:FFT:SPECtrogram:THReshold:UPPer <Threshold>
Parameters

Threshold

Real in unit See :FFT:SCALe for units
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:FFT:SPECtrogram:THReshold:UPPer?
Returns

Real in unit See :FFT:SCALe for units

:FFT:SPECtrogram:CGRading <Grading>
Parameters

Grading

HEATmap7
HEATmap5
GRADient2

:FFT:SPECtrogram:CGRading?
Returns

HEATmap7

HEATmap5

GRADient2
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3.32 :FFT:CURSor
This section covers the configuration of the FFT cursor settings.

• [N] has to be replaced with an FFT channel index, for example: FFT2

:FFT:CURSor:STATe <State>
Parameters

State

ON or 1
OFF or 0

:FFT:CURSor:STATe?
Returns

ON

OFF

:FFT:CURSor:SOURce <Source>
Parameters

Source

FFT[N]

:FFT:CURSor:SOURce?
Returns

FFT[N]

:FFT:CURSor:TRACking <Tracking>
Parameters

Tracking

ON or 1
OFF or 0

:FFT:CURSor:TRACking?
Returns

ON

OFF



Batronix Innovative Tools. Excellent Service.

Batronix Magnova® SCPI Manual © 2024 by Batronix GmbH & Co. KG
24211 Preetz, Handelsweg 16, Germany / Tel. +49 4342 90786-0 / service@batronix.com / www.batronix.com 112

:FFT:CURSor:[X/Y]:STATe <State>
Parameters

State

ON or 1
OFF or 0

:FFT:CURSor:[X/Y]:STATe?
Returns

ON

OFF

:FFT:CURSor:[X/Y]:COUPling <Coupling>
Parameters

Coupling

ON or 1
OFF or 0

:FFT:CURSor:[X/Y]:COUPling?
Returns

ON

OFF

:FFT:CURSor:[A/B]:STATe <State>
Parameters

State

ON or 1
OFF or 0

:FFT:CURSor:[A/B]:STATe?
Returns

ON

OFF

:FFT:CURSor:[A/B]:[X/Y]:STATe <State>
Parameters

State

ON or 1
OFF or 0



Batronix Innovative Tools. Excellent Service.

Batronix Magnova® SCPI Manual © 2024 by Batronix GmbH & Co. KG
24211 Preetz, Handelsweg 16, Germany / Tel. +49 4342 90786-0 / service@batronix.com / www.batronix.com 113

:FFT:CURSor:[A/B]:[X/Y]:STATe?
Returns

ON

OFF

:FFT:CURSor:[A/B]:[X/Y]:POSition <Position>
Parameters

Position

Real in unit See :FFT:SCALe for units

:FFT:CURSor:[A/B]:[X/Y]:POSition?
Returns

Real in unit See :FFT:SCALe for units
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3.33 :FFT:MARKer
This section covers the configuration of the FFT markers.

• [N] has to be replaced with an FFT channel index, for example: FFT3

• [MarkerN] has to be replaced with a marker index, for example: MARKer4

• Markers are automatically added when a setting is changed for a non-existent marker.

:FFT:MARKer:STATe <State>
Parameters

State

ON or 1
OFF or 0

:FFT:MARKer:STATe?
Returns

ON

OFF

:FFT:MARKer:SOURce <Source>
Parameters

Source

FFT[N]

:FFT:MARKer:SOURce?
Returns

FFT[N]

:FFT:MARKer:CLEar

:FFT:MARKer[MarkerN]:STATe <State>
Parameters

State

ON or 1
OFF or 0

:FFT:MARKer[MarkerN]:STATe?
Returns

ON

OFF
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:FFT:MARKer[MarkerN]:FREQuency <Frequency>
Parameters

Frequency

Real in Hz

:FFT:MARKer[MarkerN]:FREQuency?
Returns

Real in Hz

:FFT:MARKer[MarkerN]:AMPLitude <Amplitude>
Parameters

Amplitude

Real in unit See :FFT:SCALe for units

:FFT:MARKer[MarkerN]:AMPLitude?
Returns

Real in unit See :FFT:SCALe for units

:FFT:MARKer[MarkerN]:ADD

:FFT:MARKer[MarkerN]:REMove
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3.34 :DECode
This section covers adding, removing and configuring decode instances.

• [N] has to be replaced with a decode instance index, for example: DECode2

• Decode instances are automatically created when a setting is changed for a non-existent instance.

:DECode:STATe <State>
Parameters

State

ON or 1
OFF or 0

:DECode:STATe?
Returns

ON

OFF

:DECode:CLEar

:DECode[N]:STATe <State>
Parameters

State

ON or 1
OFF or 0

:DECode[N]:STATe?
Returns

ON

OFF

:DECode[N]:NFORmat <Format>
Parameters

Format

BIN
DEC
HEX
ASCii
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:DECode[N]:NFORmat?
Returns

BIN

DEC

HEX

ASCii

:DECode[N]:TABLe <Table>
Parameters

Table

ON or 1
OFF or 0

:DECode[N]:TABLe?
Returns

ON

OFF

:DECode[N]:ADD

:DECode[N]:REMove
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3.35 :DECode[N]:I2C
This section covers the configuration of the I2C bus for decode instances.

• [N] has to be replaced with a decode instance index, for example: DECode2

• Decode instances are automatically created when a setting is changed for a non-existent instance.

:DECode[N]:I2C:CLOCk:SOURce <Source>
Parameters

Source

[Channel]]

:DECode[N]:I2C:CLOCk:SOURce?
Returns

[Channel]

:DECode[N]:I2C:CLOCk:SLOPe <Slope>
Parameters

Slope

RISing
FALLing

:DECode[N]:I2C:CLOCk:SLOPe?
Returns

RISing

FALLing

:DECode[N]:I2C:CLOCk:THReshold:LOWer <Threshold>
Parameters

Threshold

Real in V or A

:DECode[N]:I2C:CLOCk:THReshold:LOWer?
Returns

Real in V or A

:DECode[N]:I2C:CLOCk:THReshold:UPPer <Threshold>
Parameters

Threshold

Real in V or A
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:DECode[N]:I2C:CLOCk:THReshold:UPPer?
Returns

Real in V or A

:DECode[N]:I2C:DATa:SOURce <Source>
Parameters

Source

[Channel]

:DECode[N]:I2C:DATa:SOURce?
Returns

[Channel]

:DECode[N]:I2C:DATa:ACTive <Active>
Parameters

Active

HIGH
LOW

:DECode[N]:I2C:DATa:ACTive?
Returns

HIGH

LOW

:DECode[N]:I2C:DATa:THReshold:LOWer <Threshold>
Parameters

Threshold

Real in V or A

:DECode[N]:I2C:DATa:THReshold:LOWer?
Returns

Real in V

:DECode[N]:I2C:DATa:THReshold:UPPer <Threshold>
Parameters

Threshold

Real in V or A
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:DECode[N]:I2C:DATa:THReshold:UPPer?
Returns

Real in V
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3.36 :DECode[N]:SPI
This section covers the configuration of the SPI bus for decode instances.

• [N] has to be replaced with a decode instance index, for example: DECode2

• Decode instances are automatically created when a setting is changed for a non-existent instance.

:DECode[N]:SPI:TIMeout <Timeout>
Parameters

Timeout

Real in s

:DECode[N]:SPI:TIMeout?
Returns

Real in s

:DECode[N]:SPI:BITS <Bits>
Parameters

Bits

Integer

:DECode[N]:SPI:BITS?
Returns

Integer

:DECode[N]:SPI:BORDer <Order>
Parameters

Order

MSBFirst
LSBFirst

:DECode[N]:SPI:BORDer?
Returns

MSBFirst

LSBFirst

:DECode[N]:SPI:CSELect:SOURce <Source>
Parameters

Source

[Channel]
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:DECode[N]:SPI:CSELect:SOURce?
Returns

[Channel]

:DECode[N]:SPI:CSELect:ACTive <Active>
Parameters

Active

HIGH
LOW

:DECode[N]:SPI:CSELect:ACTive?
Returns

HIGH

LOW

:DECode[N]:SPI:CSELect:THReshold:LOWer <Threshold>
Parameters

Threshold

Real in V or A

:DECode[N]:SPI:CSELect:THReshold:LOWer?
Returns

Real in V

:DECode[N]:SPI:CSELect:THReshold:UPPer <Threshold>
Parameters

Threshold

Real in V

:DECode[N]:SPI:CSELect:THReshold:UPPer?
Returns

Real in V

:DECode[N]:SPI:CLOCk:SOURce <Source>
Parameters

Source

[Channel]
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:DECode[N]:SPI:CLOCk:SOURce?
Returns

[Channel]

:DECode[N]:SPI:CLOCk:SLOPe <Slope>
Parameters

Slope

RISing
FALLing

:DECode[N]:SPI:CLOCk:SLOPe?
Returns

RISing

FALLing

:DECode[N]:SPI:CLOCk:THReshold:LOWer <Threshold>
Parameters

Threshold

Real in V or A

:DECode[N]:SPI:CLOCk:THReshold:LOWer?
Returns

Real in V or A

:DECode[N]:SPI:CLOCk:THReshold:UPPer <Threshold>
Parameters

Threshold

Real in V or A

:DECode[N]:SPI:CLOCk:THReshold:UPPer?
Returns

Real in V or A

:DECode[N]:SPI:MOSi:SOURce <Source>
Parameters

Source

[Channel]
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:DECode[N]:SPI:MOSi:SOURce?
Returns

[Channel]

:DECode[N]:SPI:MOSi:ACTive <Active>
Parameters

Active

HIGH
LOW

:DECode[N]:SPI:MOSi:ACTive?
Returns

HIGH

LOW

:DECode[N]:SPI:MOSi:THReshold:LOWer <Threshold>
Parameters

Threshold

Real in V or A

:DECode[N]:SPI:MOSi:THReshold:LOWer?
Returns

Real in V

:DECode[N]:SPI:MOSi:THReshold:UPPer <Threshold>
Parameters

Threshold

Real in V or A

:DECode[N]:SPI:MOSi:THReshold:UPPer?
Returns

Real in V

:DECode[N]:SPI:MISo:SOURce <Source>
Parameters

Source

[Channel]
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:DECode[N]:SPI:MISo:SOURce?
Returns

[Channel]

:DECode[N]:SPI:MISo:ACTive <Active>
Parameters

Active

HIGH
LOW

:DECode[N]:SPI:MISo:ACTive?
Returns

HIGH

LOW

:DECode[N]:SPI:MISo:THReshold:LOWer <Threshold>
Parameters

Threshold

Real in V or A

:DECode[N]:SPI:MISo:THReshold:LOWer?
Returns

Real in V

:DECode[N]:SPI:MISo:THReshold:UPPer <Threshold>
Parameters

Threshold

Real in V or A

:DECode[N]:SPI:MISo:THReshold:UPPer?
Returns

Real in V
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3.37 :DECode[N]:UART
This section covers the configuration of the UART bus for decode instances.

• [N] has to be replaced with a decode instance index, for example: DECode2

• Decode instances are automatically created when a setting is changed for a non-existent instance.

:DECode[N]:UART:BRATe <Rate>
Parameters

Rate

Integer in bps

:DECode[N]:UART:BRATe?
Returns

Integer in bps

:DECode[N]:UART:PARity <Parity>
Parameters

Parity

NONe
EVEN
ODD
MARK
SPACe

:DECode[N]:UART:PARity?
Returns

NONe

EVEN

ODD

MARK

SPACe

:DECode[N]:UART:SBIT <Bit>
Parameters

Bit

1
1.5
2



Batronix Innovative Tools. Excellent Service.

Batronix Magnova® SCPI Manual © 2024 by Batronix GmbH & Co. KG
24211 Preetz, Handelsweg 16, Germany / Tel. +49 4342 90786-0 / service@batronix.com / www.batronix.com 127

:DECode[N]:UART:SBIT?
Returns

1

1.5

2

:DECode[N]:UART:BITS <Rate>
Parameters

Rate

Integer

:DECode[N]:UART:BITS?
Returns

Integer

:DECode[N]:UART:BORDer <Order>
Parameters

Order

MSBFirst
LSBFirst

:DECode[N]:UART:BORDer?
Returns

MSBFirst

LSBFirst

:DECode[N]:UART:RTX:SOURce <Source>
Parameters

Source

[Channel]

:DECode[N]:UART:RTX:SOURce?
Returns

[Channel]
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:DECode[N]:UART:RTX:ACTive <Active>
Parameters

Active

HIGH
LOW

:DECode[N]:UART:RTX:ACTive?
Returns

HIGH

LOW

:DECode[N]:UART:RTX:THReshold:LOWer <Threshold>
Parameters

Threshold

Real in V or A

:DECode[N]:UART:RTX:THReshold:LOWer?
Returns

Real in V

:DECode[N]:UART:RTX:THReshold:UPPer <Threshold>
Parameters

Threshold

Real in V or A

:DECode[N]:UART:RTX:THReshold:UPPer?
Returns

Real in V
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3.38 :DECode[N]:PARallel
This section covers the configuration of the parallel bus for decode instances.

• [N] has to be replaced with a decode instance index, for example: DECode2

• Decode instances are automatically created when a setting is changed for a non-existent instance.

:DECode[N]:PARallel:CLOCk:SOURce <Source>
Parameters

Source

[Channel]]

:DECode[N]:PARallel:CLOCk:SOURce?
Returns

[Channel]

:DECode[N]:PARallel:CLOCk:SLOPe <Slope>
Parameters

Slope

RISing
FALLing

:DECode[N]:PARallel:CLOCk:SLOPe?
Returns

RISing

FALLing

:DECode[N]:PARallel:CLOCk:THReshold:LOWer <Threshold>
Parameters

Threshold

Real in V or A

:DECode[N]:PARallel:CLOCk:THReshold:LOWer?
Returns

Real in V or A

:DECode[N]:PARallel:CLOCk:THReshold:UPPer <Threshold>
Parameters

Threshold

Real in V or A
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:DECode[N]:PARallel:CLOCk:THReshold:UPPer?
Returns

Real in V or A

:DECode[N]:PARallel:BITS <Bits>
Parameters

Bits

Integer

:DECode[N]:PARallel:BITS?
Returns

Integer

:DECode[N]:PARallel:BIT[BitN]:SOURce <Source>
Parameters

Source

[Channel]

:DECode[N]:PARallel:BIT[BitN]:SOURce?
Returns

[Channel]

:DECode[N]:PARallel:BIT[BitN]:ACTive <Active>
Parameters

Active

HIGH
LOW

:DECode[N]:PARallel:BIT[BitN]:ACTive?
Returns

HIGH

LOW

:DECode[N]:PARallel:BIT[BitN]:THReshold:LOWer <Threshold>
Parameters

Threshold

Real in V or A
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:DECode[N]:PARallel:BIT[BitN]:THReshold:LOWer?
Returns

Real in V

:DECode[N]:PARallel:BIT[BitN]:THReshold:UPPer <Threshold>
Parameters

Threshold

Real in V or A

:DECode[N]:PARallel:BIT[BitN]:THReshold:UPPer?
Returns

Real in V
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3.39 :CURSor
This section covers the cursor configuration.

• [AnalogN] has to be replaced with an analog channel index, for example: CHANnel1

:CURSor:STATe <State>
Parameters

State

ON or 1
OFF or 0

:CURSor:STATe?
Returns

ON

OFF

:CURSor:SOURce <Source>
Parameters

Source

CHANnel[AnalogN]

:CURSor:SOURce?
Returns

CHANnel[AnalogN]

:CURSor:TDELta <State>
Parameters

State

TIMe
FREQuency
BOTH

:CURSor:TDELta?
Returns

TIMe

FREQuency

BOTH
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:CURSor:TRACking <Tracking>
Parameters

Tracking

ON or 1
OFF or 0

:CURSor:TRACking?
Returns

ON

OFF

:CURSor:[X/Y]:STATe <State>
Parameters

State

ON or 1
OFF or 0

:CURSor:[X/Y]:STATe?
Returns

ON

OFF

:CURSor:[X/Y]:COUPling <Coupling>
Parameters

Coupling

ON or 1
OFF or 0

:CURSor:[X/Y]:COUPling?
Returns

ON

OFF

:CURSor:[A/B]:STATe <State>
Parameters

State

ON or 1
OFF or 0
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:CURSor:[A/B]:STATe?
Returns

ON

OFF

:CURSor:[A/B]:[X/Y]:STATe <State>
Parameters

State

ON or 1
OFF or 0

:CURSor:[A/B]:[X/Y]:STATe?
Returns

ON

OFF

:CURSor:[A/B]:[X/Y]:POSition <Position>
Parameters

Position

Real in V, A or s

:CURSor:[A/B]:[X/Y]:POSition?
Returns

Real in V, A or s
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3.40 :FGENerator
This section covers the configuration of general function generator settings.

:FGENerator:STATe <State>
Parameters

State

ON or 1
OFF or 0

:FGENerator:STATe?
Returns

ON

OFF

:FGENerator:LOAD <Load>
Parameters

Load

HIZ
50OHM

:FGENerator:LOAD?
Returns

HIZ

50OHM
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3.41 :FGENerator:WAVeform
This section covers the configuration of function generator waveform settings.

:FGENerator:WAVeform:SHAPe <Shape>
Parameters

Shape

SINe
RECTangle
PULSe
RAMP
NOISe
ARBitrary
DC

:FGENerator:WAVeform:SHAPe?
Returns

SINe

RECTangle

PULSe

RAMP

NOISe

ARBitrary

DC

:FGENerator:WAVeform:FREQuency <Frequency>
Parameters

Frequency

Real in Hz

:FGENerator:WAVeform:FREQuency?
Returns

Real in Hz

:FGENerator:WAVeform:PERiod <Frequency>
Parameters

Frequency

Real in s
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:FGENerator:WAVeform:PERiod?
Returns

Real in s

:FGENerator:WAVeform:AMPLitude <Frequency>
Parameters

Frequency

Real in V

:FGENerator:WAVeform:AMPLitude?
Returns

Real in V

:FGENerator:WAVeform:RMS <Frequency>
Parameters

Frequency

Real in Vrms

:FGENerator:WAVeform:RMS?
Returns

Real in Vrms

:FGENerator:WAVeform:OFFSet <Frequency>
Parameters

Frequency

Real in V

:FGENerator:WAVeform:OFFSet?
Returns

Real in V

:FGENerator:WAVeform:LEVel:HIGH <Level>
Parameters

Level

Real in V
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:FGENerator:WAVeform:LEVel:HIGH?
Returns

Real in V

:FGENerator:WAVeform:LEVel:LOW <Level>
Parameters

Level

Real in V

:FGENerator:WAVeform:LEVel:LOW?
Returns

Real in V



Batronix Innovative Tools. Excellent Service.

Batronix Magnova® SCPI Manual © 2024 by Batronix GmbH & Co. KG
24211 Preetz, Handelsweg 16, Germany / Tel. +49 4342 90786-0 / service@batronix.com / www.batronix.com 139

3.42 :FGENerator:WAVeform:RECTangle
This section covers the configuration of function generator waveform rectangle settings.

:FGENerator:WAVeform:RECTangle:DUTY <Duty>
Parameters

Duty

Real in %

:FGENerator:WAVeform:RECTangle:DUTY?
Returns

Real in %
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3.43 :FGENerator:WAVeform:PULSe
This section covers the configuration of function generator waveform pulse settings.

:FGENerator:WAVeform:PULSe:DUTY <Duty>
Parameters

Duty

Real in %

:FGENerator:WAVeform:PULSe:DUTY?
Returns

Real in %

:FGENerator:WAVeform:PULSe:RTIMe <Time>
Parameters

Time

Real in s

:FGENerator:WAVeform:PULSe:RTIMe?
Returns

Real in s

:FGENerator:WAVeform:PULSe:FTIMe <Time>
Parameters

Time

Real in s

:FGENerator:WAVeform:PULSe:FTIMe?
Returns

Real in s
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3.44 :FGENerator:WAVeform:RAMP
This section covers the configuration of function generator waveform ramp settings.

:FGENerator:WAVeform:RAMP:SYMMetry <Symmetry>
Parameters

Symmetry

Real in %

:FGENerator:WAVeform:RAMP:SYMMetry?
Returns

Real in %
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3.45 :FGENerator:MODification
This section covers the configuration of function generator modification settings.

:FGENerator:MODification:TYPe <Type>
Parameters

Type

NONe
MODulation
SWEep
BURSt

:FGENerator:MODification:TYPe?
Returns

NONe

MODulation

SWEep

BURSt
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3.46 :FGENerator:MODification:MODulation
This section covers the configuration of function generator modulation modification settings.

:FGENerator:MODification:MODulation:TYPE <Type>
Parameters

Type

AM
DSSCAM
FM
PM

:FGENerator:MODification:MODulation:TYPE?
Returns

AM

DSSCAM

FM

PM

:FGENerator:MODification:MODulation:SHAPe <Shape>
Parameters

Shape

SINe
RECTangle
TRIangle
RUP
RDOwn
NOISe
ARBitrary

:FGENerator:MODification:MODulation:SHAPe?
Returns

SINe

RECTangle

TRIangle

RUP

RDOwn

NOISe

ARBitrary
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:FGENerator:MODification:MODulation:FREQuency <Frequency>
Parameters

Frequency

Real in Hz

:FGENerator:MODification:MODulation:FREQuency?
Returns

Real in Hz

:FGENerator:MODification:MODulation:AM:DEPTh <Depth>
Parameters

Depth

Real in %

:FGENerator:MODification:MODulation:AM:DEPTh?
Returns

Real in %

:FGENerator:MODification:MODulation:DSSCAM:DEPTh <Depth>
Parameters

Depth

Real in %

:FGENerator:MODification:MODulation:DSSCAM:DEPTh?
Returns

Real in %

:FGENerator:MODification:MODulation:FM:FDEViation <Deviation>
Parameters

Deviation

Real in Hz

:FGENerator:MODification:MODulation:FM:FDEViation?
Returns

Real in Hz
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:FGENerator:MODification:MODulation:PM:PDEViation <Deviation>
Parameters

Deviation

Real in degrees

:FGENerator:MODification:MODulation:PM:PDEViation?
Returns

Real in degrees
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3.47 :FGENerator:MODification:SWEep
This section covers the configuration of function generator sweep modification settings.

:FGENerator:MODification:SWEep:TYPE <Type>
Parameters

Type

LINear
LOGarithmic

:FGENerator:MODification:SWEep:TYPE?
Returns

LINear

LOGarithmic

:FGENerator:MODification:SWEep:DIRection <Direction>
Parameters

Direction

UP
DOWN
BOTH

:FGENerator:MODification:SWEep:DIRection?
Returns

UP

DOWN

BOTH

:FGENerator:MODification:SWEep:TIME:UP <Time>
Parameters

Time

Real in s

:FGENerator:MODification:SWEep:TIME:UP?
Returns

Real in s
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:FGENerator:MODification:SWEep:TIME:DOWN <Time>
Parameters

Time

Real in s

:FGENerator:MODification:SWEep:TIME:DOWN?
Returns

Real in s

:FGENerator:MODification:SWEep:FREQuency:STARt <Start>
Parameters

Start

Real in Hz

:FGENerator:MODification:SWEep:FREQuency:STARt?
Returns

Real in Hz

:FGENerator:MODification:SWEep:FREQuency:STOP <Stop>
Parameters

Stop

Real in Hz

:FGENerator:MODification:SWEep:FREQuency:STOP?
Returns

Real in Hz

:FGENerator:MODification:SWEep:HOLD:STARt <Start>
Parameters

Start

Real in s

:FGENerator:MODification:SWEep:HOLD:STARt?
Returns

Real in s
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:FGENerator:MODification:SWEep:HOLD:STOP <Stop>
Parameters

Stop

Real in s

:FGENerator:MODification:SWEep:HOLD:STOP?
Returns

Real in s
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3.48 :FGENerator:MODification:BURSt
This section covers the configuration of function generator burst modification settings.

:FGENerator:MODification:BURSt:TTYPe <Type>
Parameters

Type

AUTomatic
MANual

:FGENerator:MODification:BURSt:TTYPe?
Returns

AUTomatic

MANual

:FGENerator:MODification:BURSt:SPHase <Phase>
Parameters

Phase

Real in degrees

:FGENerator:MODification:BURSt:SPHase?
Returns

Real in degrees

:FGENerator:MODification:BURSt:CYCLes <Cycles>
Parameters

Cycles

Integer

:FGENerator:MODification:BURSt:CYCLes?
Returns

Integer

:FGENerator:MODification:BURSt:TDELay <Delay>
Parameters

Delay

Real in s
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:FGENerator:MODification:BURSt:TDELay?
Returns

Real in s

:FGENerator:MODification:BURSt:PERiod <Period>
Parameters

Period

Real in s

:FGENerator:MODification:BURSt:PERiod?
Returns

Real in s

:FGENerator:MODification:BURSt:ILTYpe <Type>
Parameters

Type

FPOint
MANual

:FGENerator:MODification:BURSt:ILTYpe?
Returns

FPOint

MANual

:FGENerator:MODification:BURSt:ILEVel <Period>
Parameters

Period

Real in %

:FGENerator:MODification:BURSt:ILEVel?
Returns

Real in %

:FGENerator:MODification:BURSt:TRIGger
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3.49 :BPLot
This section covers the configuration of the general bode plot settings and bode plot instances.

• [N] has to be replaced with a bode plot instance index, for example: BPLot3

• [AnalogN] has to be replaced with an analog channel index, for example: CHANnel1

:BPLot:STATe <State>
Parameters

State

ON or 1
OFF or 0

:BPLot:STATe?
Returns

ON

OFF

:BPLot:FSCale <Scale>
Parameters

Scale

LINear
LOGarithmic

:BPLot:FSCale?
Returns

LINear

LOGarithmic

:BPLot:VMODe <Mode>
Parameters

Mode

RATio
AMPLitude

:BPLot:VMODe?
Returns

RATio

AMPLitude
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:BPLot:ASCale <Scale>
Parameters

Scale

DBM
DBV
DBMV
DBUV
V

:BPLot:ASCale?
Returns

DBM

DBV

DBMV

DBUV

V

:BPLot:RSCale <Scale>
Parameters

Scale

LINear
LOGarithmic

:BPLot:RSCale?
Returns

LINear

LOGarithmic

:BPLot:FREQuency:CENTer <Center>
Parameters

Center

Real in Hz

:BPLot:FREQuency:CENTer?
Returns

Real in Hz
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:BPLot:FREQuency:SPAN <Span>
Parameters

Span

Real in Hz

:BPLot:FREQuency:SPAN?
Returns

Real in Hz

:BPLot:FREQuency:STARt <Start>
Parameters

Start

Real in Hz

:BPLot:FREQuency:STARt?
Returns

Real in Hz

:BPLot:FREQuency:STOP <Stop>
Parameters

Stop

Real in Hz

:BPLot:FREQuency:STOP?
Returns

Real in Hz

:BPLot[N]:STATe <State>
Parameters

State

ON or 1
OFF or 0

:BPLot[N]:STATe?
Returns

ON

OFF
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:BPLot[N]:OUT <Out>
Parameters

Out

CHANnel[AnalogN]

:BPLot[N]:OUT?
Returns

CHANnel[AnalogN]

:BPLot[N]:OFFSet <Offset>
Parameters

Offset

Real in unit See :FFT:SCALe for units

Real in ratio
Real in logarithmic ratio

:BPLot[N]:OFFSet?
Returns

Real in unit See :FFT:SCALe for units

Real in ratio

Real in logarithmic ratio

:BPLot[N]:SCALe <Scale>
Parameters

Scale

Real in unit See :BPLot:ASCale for units

Real in ratio
Real in logarithmic ratio

:BPLot[N]:SCALe?
Returns

Real in unit See :BPLot:ASCale for units

Real in ratio

Real in logarithmic ratio
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:BPLot[N]:POFFSet <Offset>
Parameters

Offset

Real in degrees

:BPLot[N]:POFFSet?
Returns

Real in degrees

:BPLot[N]:PSCALe <Scale>
Parameters

Scale

Real in degrees

:BPLot[N]:PSCALe?
Returns

Real in degrees
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3.50 :BPLot:SWEep
This section focuses on the configuration of bode plot sweep settings.

• [N] has to be replaced with a bode plot instance index, for example: BPLot3

:BPLot[N]:IN <In>
Parameters

In

CHANnel[AnalogN]

:BPLot[N]:IN?
Returns

CHANnel[AnalogN]

:BPLot:SWEep:POINts <Points>
Parameters

Points

Integer

:BPLot:SWEep:POINts?
Returns

Integer

:BPLot:SWEep:PDIStribution <Distribution>
Parameters

Distribution

LINear
LOGarithmic

:BPLot:SWEep:PDIStribution?
Returns

LINear

LOGarithmic

:BPLot:SWEep:FREQuency:STARt <Start>
Parameters

Start

Real in Hz
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:BPLot:SWEep:FREQuency:STARt?
Returns

Real in Hz

:BPLot:SWEep:FREQuency:STOP <Stop>
Parameters

Stop

Real in Hz

:BPLot:SWEep:FREQuency:STOP?
Returns

Real in Hz

:BPLot:SWEep:VSCale <Scale>
Parameters

Scale

DBM
DBV
DBMV
DBUV
V

:BPLot:SWEep:VSCale?
Returns

DBM

DBV

DBMV

DBUV

V

:BPLot:SWEep:VOFFset <Offset>
Parameters

Offset

Real in unit See :BPLot:SWEep:VSCale for units

:BPLot:SWEep:VOFFset?
Returns

Real in unit See :BPLot:SWEep:VSCale for units



Batronix Innovative Tools. Excellent Service.

Batronix Magnova® SCPI Manual © 2024 by Batronix GmbH & Co. KG
24211 Preetz, Handelsweg 16, Germany / Tel. +49 4342 90786-0 / service@batronix.com / www.batronix.com 158

:BPLot:SWEep:VAMPlitude <Amplitude>
Parameters

Amplitude

Real in unit See :BPLot:SWEep:VSCale for units

:BPLot:SWEep:VAMPlitude?
Returns

Real in unit See :BPLot:SWEep:VSCale for units
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3.51 :BPLot[N]:DATa
This section focuses on the transfer of bode plot data.

• [N] has to be replaced with a bode plot instance index, for example: BPLot3

:BPLot[N]:DATa:ASCale <Scale>
Parameters

Scale

DBM
DBV
DBMV
DBUV
V

:BPLot[N]:DATa:ASCale?
Returns

DBM

DBV

DBMV

DBUV

V

:BPLot[N]:DATa:POINts?
Returns

Point data See 3.51.1.

:BPLot[N]:DATa:PACKed? <Scale>
Parameters

Scale

DBM
DBV
DBMV
DBUV
V

Returns

Packed point data See 3.51.2.
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3.51.1 Bode Plot Points

All data in this section has a Block Data header (see 1.1.3).

The Bode Plot points N is implicitly defined through the Block Data header

Field
Count
(bytes)

Data Type Json/Xml Name

Points (Frequency
/ Amplitude

/ Ratio / Phase)
4 * N

4-byte floating-point / 4-byte floating-point / 4-byte
floating-point / 4-byte floating-point

Frequency
/ Amplitude

/ Ratio / Phase

3.51.2 Bode Plot Points Packed

All data in this section has a Block Data header (see 1.1.3).

The Bode Plot points including a metadata header

Field
Count
(bytes)

Data Type Json/Xml Name

N = Number of
points

4 4-byte unsigned integer PointCount

Points (Frequency
/ Amplitude

/ Ratio / Phase)
4 * N

4-byte floating-point / 4-byte floating-point / 4-byte
floating-point / 4-byte floating-point

Frequency
/ Amplitude

/ Ratio / Phase
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3.52 :HISTory
This section covers the configuration of the history.

:HISTory:STATe <State>
Parameters

State

ON or 1
OFF or 0

:HISTory:STATe?
Returns

ON

OFF

:HISTory:RECord <Record>
Parameters

Record

Integer starting at 1

:HISTory:RECord?
Returns

Integer starting at 1

:HISTory:TOTal?
Returns

Integer

:HISTory:NEXT

:HISTory:PREVious

:HISTory:PLAY <Play>
Parameters

Play

Integer between -5 and 5 Default 1, specifies the direction and speed of
the playback

:HISTory:STOP
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:HISTory:REPeat <Repeat>
Parameters

Repeat

ON or 1
OFF or 0

:HISTory:REPeat?
Returns

ON

OFF
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3.53 :DISPlay
This section covers the configuration of the display settings.

:DISPlay:BRIGhtness <Brightness>
Parameters

Brightness

Integer between 0 and 100

:DISPlay:BRIGhtness?
Returns

Integer between 0 and 100

:DISPlay:SCReenshot? <Format>
Parameters

Format

BMP
PNG

Returns

Screenshot data The data in the specified format can be saved
directly to a file
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3.54 :DISPlay:WAVeform
This section covers the configuration of the display waveform settings.

:DISPlay:WAVeform:INTerpolation <Interpolation>
Parameters

Interpolation

NONe
HOLD
LINear
SINC

:DISPlay:WAVeform:INTerpolation?
Returns

NONe

HOLD

LINear

SINC

:DISPlay:WAVeform:INTENSITY <Intensity>
Parameters

Intensity

Integer between 0 and 100

:DISPlay:WAVeform:INTENSITY?
Returns

Integer between 0 and 100

:DISPlay:WAVeform:COLor <Color>
Parameters

Color

INTensity
INVerted
HEATmap7
HEATmap5
GRADient2
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:DISPlay:WAVeform:COLor?
Returns

INTensity

INVerted

HEATmap7

HEATmap5

GRADient2

:DISPlay:WAVeform:PERSistence <Persistence>
Parameters

Persistence

OFF
INFinite
Real in s

:DISPlay:WAVeform:PERSistence?
Returns

OFF

INFinite

Real in s



Batronix Innovative Tools. Excellent Service.

Batronix Magnova® SCPI Manual © 2024 by Batronix GmbH & Co. KG
24211 Preetz, Handelsweg 16, Germany / Tel. +49 4342 90786-0 / service@batronix.com / www.batronix.com 166

3.55 :DISPlay:GRID
This section covers the configuration of the display grid settings.

:DISPlay:GRID:DETail <Detail>
Parameters

Detail

NONe
SIMPle
NORMal
FINe

:DISPlay:GRID:DETail?
Returns

NONe

SIMPle

NORMal

FINe

:DISPlay:GRID:INTensity <Intensity>
Parameters

Intensity

LOW
HIGH

:DISPlay:GRID:INTensity?
Returns

LOW

HIGH

:DISPlay:GRID:MLABel <Label>
Parameters

Label

HIDDen
ONCHange
VISible
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:DISPlay:GRID:MLABel?
Returns

HIDDen

ONCHange

VISible
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3.56 :ZOOM
This section covers the configuration of the zoom.

:ZOOM:STATe <State>
Parameters

State

ON or 1
OFF or 0

:ZOOM:STATe?
Returns

ON

OFF

:ZOOM:HORizontal:POSition <Offset>
Parameters

Offset

Real in %

:ZOOM:HORizontal:POSition?
Returns

Real in %

:ZOOM:HORizontal:SCALe <Offset>
Parameters

Offset

Real

:ZOOM:HORizontal:SCALe?
Returns

Real

:ZOOM:VERTical:POSition <Offset>
Parameters

Offset

Real in %
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:ZOOM:VERTical:POSition?
Returns

Real in %

:ZOOM:VERTical:SCALe <Offset>
Parameters

Offset

Real

:ZOOM:VERTical:SCALe?
Returns

Real
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